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Willkommen!

This documentation provides information on some of the most common topics on using Xubuntu. The complete
set of topics is listed below.

If you require help with a topic or problem that is not addressed by the documentation,
you can visit the Help & Support [http://xubuntu.org/help/] page of the Xubuntu website for
a full list of additional help resources. Some of these resources include live chat on the
#xubuntu [https://web.libera.chat/?nick=xu-help?w#xubuntu] (English) IRC channel or an Ubuntu localized
[https://wiki.ubuntu.com/IRC/ChannelList#IRC.2FChannelList.2FLocal.Local_Ubuntu_channels] channel, live chat
on the Xubuntu Support [https://t.me/XubuntuSupport] Telegram group, email support on our
Xubuntu user [https://lists.ubuntu.com/mailman/listinfo/xubuntu-users] (English) mailing list or an Ubuntu
localized [https://lists.ubuntu.com/#Localization+Lists] list, Xubuntu Reddit [https://www.reddit.com/r/xubuntu/],
Xfce Forums [https://forum.xfce.org/] and Ubuntu Forums [https://ubuntuforums.org/forumdisplay.php?
f=329&pp=20&prefixid=xubuntu&sort=lastpost&order=desc&daysprune=-1] as discussion platforms, and Ask
Ubuntu [https://askubuntu.com/questions/tagged/xubuntu] for Q and A.

If you would like to contribute to Xubuntu, including this documentation, see the Get Involved [http://xubuntu.org/
contribute/] section of the Xubuntu website. Xubuntu is a community-driven project that you can participate in.
There are many areas of involvement, including artwork, bug reporting, bug triaging, testing, documentation,
translation, programming, marketing, and more. To participate you can contact the team on the #xubuntu-devel
[https://web.libera.chat/?nick=xu-contribute?w#xubuntu] IRC channel, the Xubuntu Development [https://t.me/
XubuntuDevelopment] Telegram group, or the Xubuntu Development [https://lists.ubuntu.com/mailman/listinfo/
xubuntu-devel] mailing list.
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Kapitel 1. Was ist Xubuntu?

Eine kurze Einführung

A Free Community-Developed Operating System

Xubuntu is an elegant and easy-to-use desktop operating system that comes with the Xfce desktop
environment, making it stable, light on resources and configurable.

It is perfect for those who want to make the most of their desktops, laptops and netbooks, featuring a
modern look and enough features for efficient daily usage. It also works well on older hardware, single-
board computers like the Raspberry Pi, and the Windows Subsystem for Linux (WSL).

Xubuntu was first released in 2006. It is a community-developed project led by the Xubuntu team. The team
is made up of volunteers who work on different aspects of the project including design, programming,
marketing, testing, website, documentation, and administration.

Find out more at the Xubuntu website [http://xubuntu.org/] or on Wikipedia [https://en.wikipedia.org/wiki/
Xubuntu].

About the Name

The „X“ in Xubuntu stands for Xfce, the user interface and bundled core applications that come with Xubuntu.
The „ubuntu“ in Xubuntu denotes its relationship with the Ubuntu base upon which the operating system
is built. Xubuntu is pronounced „zoo-bun-too“.
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Was ist Xubuntu?

The word „ubuntu“ represents the philosophical core of the operating system. Ubuntu can be roughly
translated as „humanity towards others.“ To read more about the philosophy and ideals behind Ubuntu
and Xubuntu, please refer to the Ubuntu Philosophy [http://www.ubuntu.com/project/about-ubuntu/our-
philosophy] page.

Releases and Version Numbers

Xubuntu produces a new Long Term Support (LTS) release every 2 years. These releases are supported for
3 years and are a popular choice for users that prefer stability over new features. Every 6 months, a new
interim release is made available for users who want to use the latest features at the cost of a shorter, 9-
month support cycle. New releases are produced every April and October.

Xubuntu follows the Ubuntu version numbering scheme, which is based on the distribution release date.
The first part of the release denotes the year, while the second part denotes the month. For example, the
first official Xubuntu version was released in June, 2006, thus its version number was 6.06.

Editions

There are two editions of Xubuntu: Xubuntu Desktop and Xubuntu Core. Xubuntu Desktop targets the
regular user and comes with a collection of preinstalled software carefully curated by the Xubuntu team.
It includes a suite of tools appropriate for most tasks, from image and document editing to web browsing
and more.

Xubuntu Core is a slimmed-down edition of Xubuntu Desktop, with apps just for the basic tasks, such as file
management and terminal emulation. This results in a smaller download ISO, with fewer preinstalled plugins
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Was ist Xubuntu?

and libraries, that will be even lighter on resources. This edition is targeting users who want to install just
the apps they want to suit their specific needs from a cleaner base, so they can create their own custom OS.

What Makes Up Xubuntu

Free and Open Source Software

The Xubuntu project is entirely committed to the principles of free software development where people are
encouraged to use software that protects their freedoms, view its source code, improve it, and pass it on.
You can find out more about free software and the ideological and technical philosophy behind it at the
GNU website [http://www.gnu.org/].

Linux

Linux was brought to life in 1991 by a Finnish student named Linus Torvalds. At the heart of the Xubuntu
operating system lies the Linux kernel. The kernel is an important part of any operating system, providing
the communication bridge between hardware and software. Read more about Linux at the Linux kernel
website [http://www.kernel.org/].
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Xfce

Xfce is the lightweight desktop environment used in Xubuntu. It aims to be fast and low on system resources,
while still being visually appealing and user friendly. Xfce embodies the traditional UNIX philosophy of
modularity and reusability. Read more about Xfce at the Xfce website [http://www.xfce.org/].

Debian and Ubuntu

Xubuntu is built on the hard work of the Debian and Ubuntu GNU/Linux distributions. Based on Ubuntu,
Xubuntu supports a wide variety of hardware and provides access to a large archive of free and open source
software. Much of this software, including the packages that compose the Xfce desktop environment, are
made available by the Debian Xfce team.
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Preparation
Prerequisites

Visit the System Requirements [https://xubuntu.org/requirements/] page to ensure that your computer
meets the necessary hardware requirements to install and run Xubuntu. In general, Xubuntu will run on
most computers (PC or Mac) that were built since 2007 and shipped with an OS (Operating System) like
Windows XP and Mac OS X 10.5 or higher.

Anmerkung

If you are installing Xubuntu on a laptop, it is recommended to keep your laptop plugged in during
the installation, in order to prevent a sudden power loss which can cause a corrupted system. If you
are running Windows 10 and have Intel's RST (Rapid Storage Technology) running, you will need to
turn it off [https://help.ubuntu.com/rst/] before installation.

Download the ISO

Visit the Download [https://xubuntu.org/download/] page to download the ISO image for your selected
edition of Xubuntu. If you prefer stability, it is recommended to download the LTS (Long Term Support)
release, which is supported for 3 years. The ISO file can be downloaded with a BitTorrent client,
such as Transmission [https://transmissionbt.com/download/] or qBittorrent [https://www.qbittorrent.org/
download.php], or through your browser from one of the many global mirror servers.

Write the ISO

The ISO file needs to be written to a bootable medium, like a USB flash drive, an SD memory card or a DVD
optical disk.

Write to USB or SD

If you have a USB stick or an SD card with 2 GB of storage or more, you can use one of
these apps to write the ISO file: Rufus [https://rufus.ie/] (Windows), Etcher [https://www.balena.io/

etcher/] (Windows, Mac, Linux), GNOME Disks [https://wiki.gnome.org/Apps/Disks] ( gnome-disk-utility
[apt://gnome-disk-utility]). For more information on how to write the ISO to USB or SD, please
see these guides for Windows [https://ubuntu.com/tutorials/tutorial-create-a-usb-stick-on-windows#3-
usb-selection], Mac [https://ubuntu.com/tutorials/tutorial-create-a-usb-stick-on-macos#3-prepare-the-usb-
stick] or Linux [https://www.maketecheasier.com/create-bootable-usb-installer-ubuntu-gnome-disks/].

Write to DVD

If you have a blank DVD disk and a DVD writer drive, you can burn the ISO with one of these apps, if your
operating system doesn’t have the built-in capabilities to do so: InfraRecorder [http://infrarecorder.org/?
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page_id=5] (Windows), Brasero [https://wiki.gnome.org/Apps/Brasero/] ( brasero [apt://brasero]),
Xfburn [https://docs.xfce.org/apps/xfburn] ( xfburn [apt://xfburn]). For more information on how to
burn the ISO to a DVD, please see these guides for Windows [https://ubuntu.com/tutorials/tutorial-burn-
a-dvd-on-windows#2-windows-7--8--10-instructions], Mac [https://ubuntu.com/tutorials/tutorial-burn-a-
dvd-on-macos#2-select-the-ubuntu-iso] or Linux [https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-
ubuntu#3-install-brasero].

Backup Data

If you plan to install Xubuntu alongside an existing OS, it is recommended to back up the data of the existing
OS as a precaution in case something goes wrong. You can back up the data files to an external USB drive
and/or to a secondary hard drive on your computer.

Booting

BIOS / UEFI Considerations

Some computers may require additional configuration before the Xubuntu installation medium can be
booted. Please refer to this section if you are unable to boot into the installer or if your hardware is not
properly detected.

Warning: This is an advanced computer feature and should only be attempted with caution. F2 and Del
are common keys to access the BIOS settings.

• Intel RST

• Secure Boot [https://wiki.ubuntu.com/UEFI/SecureBoot] / Windows 8/10 [https://
windows.gadgethacks.com/how-to/access-boot-menu-and-bios-windows-8-0139059/] / Fast Boot
[https://www.tenforums.com/tutorials/21284-enable-disable-fast-boot-uefi-firmware-settings-
windows.html] / Fast Startup [https://winaero.com/blog/how-to-disable-or-enable-fast-startup-in-
windows-8-1/]

• macOS T.2 Security

Starting the Bootable Medium

Insert the bootable medium into the respective device (the USB drive in a USB port, the SD card in the SD
card reader or the DVD disk in the DVD drive) and restart your computer. If your computer is set to first

6

http://infrarecorder.org/?page_id=5
https://wiki.gnome.org/Apps/Brasero/
https://wiki.gnome.org/Apps/Brasero/
apt://brasero
apt://brasero
https://docs.xfce.org/apps/xfburn
https://docs.xfce.org/apps/xfburn
apt://xfburn
apt://xfburn
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-windows#2-windows-7--8--10-instructions
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-windows#2-windows-7--8--10-instructions
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-windows#2-windows-7--8--10-instructions
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-macos#2-select-the-ubuntu-iso
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-macos#2-select-the-ubuntu-iso
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-macos#2-select-the-ubuntu-iso
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-ubuntu#3-install-brasero
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-ubuntu#3-install-brasero
https://ubuntu.com/tutorials/tutorial-burn-a-dvd-on-ubuntu#3-install-brasero
https://wiki.ubuntu.com/UEFI/SecureBoot
https://wiki.ubuntu.com/UEFI/SecureBoot
https://windows.gadgethacks.com/how-to/access-boot-menu-and-bios-windows-8-0139059/
https://windows.gadgethacks.com/how-to/access-boot-menu-and-bios-windows-8-0139059/
https://windows.gadgethacks.com/how-to/access-boot-menu-and-bios-windows-8-0139059/
https://www.tenforums.com/tutorials/21284-enable-disable-fast-boot-uefi-firmware-settings-windows.html
https://www.tenforums.com/tutorials/21284-enable-disable-fast-boot-uefi-firmware-settings-windows.html
https://www.tenforums.com/tutorials/21284-enable-disable-fast-boot-uefi-firmware-settings-windows.html
https://winaero.com/blog/how-to-disable-or-enable-fast-startup-in-windows-8-1/
https://winaero.com/blog/how-to-disable-or-enable-fast-startup-in-windows-8-1/
https://winaero.com/blog/how-to-disable-or-enable-fast-startup-in-windows-8-1/


Installation

boot from the bootable medium of your choice, then the medium will automatically boot. If it doesn’t start
automatically, please refer to the computer manufacturer’s documentation for entering the boot menu. This

could consist of pressing a key, such as F12, or using a dedicated button on the computer. In some cases,
you may need to boot into Windows to access the BIOS. Once you have entered the boot menu, select the
appropriate boot medium device.

Anmerkung

The key to press for your computer’s boot menu will depend on the manufacturer of the computer

or motherboard. F12 is the most common boot menu key, but other common alternative keys

are Escape and F10. Less common keys include F11, F9, and F8. If your computer
is not capable of booting through USB, but has a CD or DVD drive, you can utilize PLoP [http://
www.howtogeek.com/howto/16822/boot-from-a-usb-drive-even-if-your-BIOS-wont-let-you/].

Booting the Installer

Once the bootable media starts, a blank screen will appear with a keyboard and accessibility icons. At this
point, you have 5 seconds to press any key to access the installer boot menu, if you wish to. The boot menu
will initially present a language selection menu, followed by a simple menu with options to install or try

Xubuntu, test memory, boot from the hard disk, as well as other options accessible by pressing the F1
through F6 keys (for more information about the Fn keys options, click here [https://help.ubuntu.com/
community/BootOptions#Changing_the_CD.27s_Default_Boot_Options]).
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Integrity Check

After the initial boot screen, releases of Xubuntu 20.04 and later default to checking the integrity of the install

media, which can be skipped by pressing Ctrl+C. This check is important as it is common for corrupted
installation media to cause failed installations.

Anmerkung

If you get a black screen after the integrity check, reboot your system and select one of the safe
graphics options in the GRUB menu. This sometimes happens when graphics cards don’t work properly
with their open source drivers. If this happens after installation with your NVidia graphics card, select
the ‘recovery mode’ option in the GRUB menu and then install the proprietary NVidia graphics driver
from the Additional Drivers app.
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Installer

Welcome Screen

You will be greeted with the installer’s welcome screen when the installer begins. There you can select
the language of the installer from the list on the left and press the Install Xubuntu button to begin the
installation process.
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Anmerkung

If you selected one of the Try Xubuntu ... entries in the installer boot menu or the Try Xubuntu button
on the welcome screen, you can start or restart the installer by clicking the Install Xubuntu desktop icon.

Initial Steps

The next screen of the installer will be the Keyboard layout screen. There you can select your keyboard layout,
if it wasn’t correctly detected. If you are unsure of your keyboard layout, you may press the Detect Keyboard
Layout button to go through a brief configuration procedure and test that the layout works as intended in
the keyboard test field. Click the Continue button to proceed.

If you are not connected to the internet but your computer has Wi-Fi, you will see the Wireless screen, where
you can either connect to one of the available networks or continue without connecting.

After clicking the Continue button, you will arrive at the Updates and other software screen. There you have
the options to download updates during the installation, if you have an internet connection, and whether
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to install third-party software, like the Nvidia graphics card driver and multimedia codecs for playing media
files. It is recommended to have both of them checked.
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Anmerkung

Note: If Download updates while installing Xubuntu was disabled or unselected, you can run the
Software Updater application after the installation. If Install third-party software for graphics and
Wi-Fi hardware and additional media formats was unselected during installation, you can open the
Software & Updates app after the installation, enable the Proprietary drivers for devices (restricted)
repository on the Ubuntu Software tab, and then install the drivers on the Additional Drivers tab

to install drivers. You would also need to install the ubuntu-restricted-extras [apt://ubuntu-
restricted-extras] package.

Disk Space Allocation

The next screen of the installer is the Installation type screen, which will vary in its list of installation and
reinstallation options depending on which operating system(s) are currently on your hard disk. Regular
users are recommended to choose either Erase disk and install Xubuntu, to completely wipe the disk and
install Xubuntu as the only OS, or Install Xubuntu alongside [OS], to create a dual boot setup with Xubuntu
and an existing operating system ([OS] is the existing OS, e.g. Microsoft Windows XP Professional in the
screenshot). Advanced users can choose the Something else option, which gives them the ability to create,
format, delete and assign partitions.
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If you choose to install Xubuntu alongside another existing operating system, you will be given the option
to adjust how much hard disk space Xubuntu will use after you click the Continue button.

When no OS is found
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When an OS is found
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Options to reinstall
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Adjust space taken by Xubuntu

Disk Changes Confirmation

When clicking the Install Now button, the installer will show a confirmation dialog before it makes non-
reversible changes to your hard disk's partitions and data. Read the changes carefully and, if you agree,
click the Continue button.
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Write automated disk changes
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Write alongside disk changes

Select Your Location

The next screen of the installer will be the Where are you? screen. There you can type the name of the town
or city in the text field or click on the map to select your time zone. If you are connected to the internet, your
location will be automatically detected. Click the Continue button to proceed.

Login Details

At the Who are you? screen, once you enter your name, a computer name and username will be automatically
suggested. You can change both as you prefer. The computer name, aka hostname, is the name your
computer will have when it appears on the network, while the username will be your login and account
name.

Next, enter a password, which will be evaluated, yielding a grade of 'short', 'weak', 'fair', 'good' or 'strong'. A
strong password is one with a minimum of 8 characters, containing a mixture of uppercase letters, lowercase
letters, numbers and symbols. It is highly recommended to use a strong password. You then have the option
to select whether your computer will require you to type your password to log in when you first turn it on
or have it log in automatically. You will always be required to type your password if you lock your computer
or if the screen times out due to inactivity.
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Anmerkung

It is recommended to store your passwords in a password manager application, like KeePassXC

[https://keepassxc.org/] ( keepassxc [apt://keepassxc]) or Bitwarden [https://bitwarden.com/
#download], which can also generate passwords for you.

Background Installation

The installer will now begin installing Xubuntu in the background. While this is happening, installation slides
will teach you a little bit more about Xubuntu, its support channels and community.
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Installation Completion

After all the files have been copied to the hard disk and the configurations have been set, a dialog window will
appear asking to restart the computer. Click the Restart Now button and you will be prompted to remove

the installation medium and press Enter to restart.
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Conclusion
Congratulations! You have successfully installed Xubuntu and now it’s time to start enjoying it. Once the
computer restarts, you will either be automatically started into Xubuntu and see the login screen or, if you
have multiple operating systems installed on your hard disk, the GRUB boot menu, which lets you choose
between starting Xubuntu or another installed OS.
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Kapitel 3. Introduction
Startup

If you have installed Xubuntu alongside another OS (Operating System), also known as dual booting, then
you will be presented with the GRUB boot menu when you turn on your computer. This menu gives you
options to start Xubuntu, start Xubuntu with advanced options, run a memory test or start other OSes. You
may press the Escape key before booting to access the GRUB menu if you are not on a dual boot system.

Once the booting process begins, you will see the Xubuntu splash screen with a circular animation.

Anmerkung

If you would like to customize the look and behaviour of the GRUB boot menu, you can

install Grub Customizer ( grub-customizer [apt://grub-customizer], PPA [https://launchpad.net/
~danielrichter2007/+archive/ubuntu/grub-customizer])

Login Screen

When the booting process is complete, the login screen appears. It contains a panel at the top and a login
dialog in the center of the screen. From left to right, the panel contains the computer name, the session
selector, locale/language selector, accessibility options selector, date & time, and log out options.

The login dialog allows you to select an account name and type in the password to log into that session.
You will not see the login screen if you selected the Log in automatically option on the Who are you? screen
of the installer.
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Anmerkung

To enable or disable automatic login of a user account, open Users and Groups, found in the 

Applications Menu or  Settings Manager, select the account in the list on the left, click the
Change... button on the Password line and check or uncheck the Don’t ask for password on login
checkbox. To configure the appearance of the login screen, open LightDM GTK+ Greeter settings.

Arbeitsumgebung
Similar to the login screen, the default Xubuntu desktop has a single panel located at the top of the screen,
along with a wallpaper and desktop icons.
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Panel

The panel is used for launching and switching applications as well as providing easy access to interactive
system status indicators in order to see and change the status of important components of your system.

On the left side of the panel you will find the  Applications Menu button, which has the icon of the
Xubuntu logo. Next to that is the list of running applications with available windows, known as the window
list or taskbar buttons.

On the right of the panel is the Notification Area, which contains indicators showing status information,
like network connectivity and sound volume level. The first indicator on the far right is the clock, which
displays the system date and time. Clicking on the clock displays the calendar. Some indicator icons appear
and disappear based on context. The bluetooth icon, for example, will appear when a bluetooth adapter is
present. The notification area also hosts system tray icons of running applications that support this feature,
such as Transmission or Audacious.
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Anmerkung

The location of the panel and its components along with various options can be customized by right-
clicking on the panel and selecting Panel → Panel Preferences.

Applications Menu

Clicking the  Applications Menu button on the panel or pressing the Ctrl+Escape keyboard shortcut
will open the menu, which has five (5) sections:

1. A search field to filter installed applications.

2. A column listing application categories.
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3. A list of applications in the selected category. Favorites is selected and displayed by default.

4. The user account’s name and photograph.

5. Command buttons for the  Settings Manager,  locking the screen and the  log out dialog.

Anmerkung

To customize the appearance and behaviour of the  Applications Menu, right-click the  menu
icon and select Properties. To customize which applications appear in the menu and their properties

(icon, text, command), right-click the  menu icon and select Edit Applications or open Menu Editor.

Desktop Icons and Wallpaper

The default desktop has three primary icons -- Home, File System and Trash -- as well as icons for partitions and
removable devices, if they are present. Additional files, folders, application launchers and website shortcuts
can be added to the desktop and can be manually or automatically arranged. You can set the desktop
wallpaper and which desktop icons are visible, as well as their options, by right-clicking in a blank area of
the desktop and choosing Desktop Settings from the context menu.

Session Management
Xubuntu provides a collection of commands for managing your session. These commands are accessible

from the command buttons section of the  Applications Menu as well as through shortcut keys.

The first of the these commands is the  Lock Screen button, which locks the current session and presents
the login dialog to resume the session. Locking the screen is also accessible by two keyboard shortcuts:

Super+L and Ctrl+Alt+L.
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The remaining session commands are accessible through the  Log Out button, as well as the Ctrl+Alt
+Delete keyboard shortcuts, which opens a dialog and gives access to commands to:

1. Log Out - End the current session.

2. Restart - Restart the computer.

3. Shutdown - Shut down the computer.

4. Suspend - Put the computer to sleep and have it run with minimal power.

5. Hibernate - Save the current desktop session and shut down the computer. When you restart the
computer, you will resume the session.

6. Switch User - Log in to another user account.

Anmerkung

It is possible to access the session management commands from the panel by right-clicking on the
panel and then Panel → Add New Items... and then adding the Action Buttons entry. It is also possible

to add additional session management commands to the  Applications Menu by right-clicking the
Menu icon and selecting Properties and then enabling them in the Commands tab.

Anmerkung

Hibernation is disabled by default in Xubuntu and instructions to enable it can be found in
„Ruhezustand aktivieren“.
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Kapitel 4. Default Applications
Xubuntu comes with a collection of preinstalled applications curated by the Xubuntu team which are

accessible from the  Applications Menu ( Ctrl+Escape) as well as the Application Finder ( Alt+F3 or

Super+R).

Favorites 
By default, Xubuntu displays a number of commonly used applications in the Favorites category of the

 Applications Menu. These applications include the software manager, word processor, and help
documentation, as well as the default web browser and file manager. To add or remove entries from the
Favorites category, right-click on an application entry and select the Add to Favorites or Remove from Favorites
entry in the context menu.

Anmerkung

To change the default web browser, mail reader, file manager, terminal emulator and more, open the
Default Applications app.

Accessories 
 Catfish is a file search utility that is able to locate files by name, text content and more. It provides

external search capability to the Thunar file manager.

Links: Website [https://bluesabre.org/catfish/], Documentation [https://docs.xfce.org/apps/catfish/usage],
Donate [https://bluesabre.org/donate/]

Alternatives: MATE Search ( mate-utils [apt://mate-utils]), FSearch [https://
cboxdoerfer.github.io/fsearch/], ANGRYsearch [https://github.com/DoTheEvo/ANGRYsearch], Recoll
[https://www.lesbonscomptes.com/recoll/]

Anmerkung

The search results can be enhanced by the installation of zeitgeist user activity logging service

( zeitgeist [apt://zeitgeist]).

 Engrampa is an archive manager which provides the ability to create, view, modify, and extract data
from archive files such as .zip and .gz files.

Alternatives: File Roller ( file-roller [apt://file-roller]), Xarchiver ( xarchiver [apt://xarchiver])

Anmerkung

To open a .RAR file, the p7zip-rar [apt://p7zip-rar] package is required.
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Default Applications

 MATE Calculator is designed to resemble a hand-held calculator and has basic, advanced, financial, and
programming modes.

Alternatives: Galculator ( galculator [apt://galculator]), GNOME Calculator ( gnome-calculator
[apt://gnome-calculator]), Speedcrunch ( speedcrunch [apt://speedcrunch])

 Mousepad is a simple text editor with features for displaying line numbers and white space, word
wrapping, source code syntax highlighting, etc.

Links: Website [https://gitlab.xfce.org/apps/mousepad], Documentation [https://docs.xfce.org/apps/
mousepad/start]

Alternatives: Pluma ( pluma [apt://pluma]), GEdit ( gedit [apt://gedit]), Geany ( geany [apt://
geany]), Visual Studio Code [https://code.visualstudio.com/Download]

 Screenshot is a screen capture utility that lets you capture the entire screen, an active application
window, or a region of the screen.

Links: Website [https://gitlab.xfce.org/apps/xfce4-screenshooter], Documentation [https://docs.xfce.org/
apps/xfce4-screenshooter/start]

Anmerkung

The three capture modes can be activated with the PrintScreen, Alt+PrintScreen and Shift
+PrintScreen keyboard shortcuts, respectively.

Games 
 Mines is a single-player puzzle game where you locate mines floating in an ocean with the help of clues

about the number of neighboring mines in the area. Clicking on a square reveals what is under it: either
empty ocean or a mine. If you click on a mine, the game is over.

 SGT Puzzles Collection is a set of over 30 unique single-player puzzle games. The games are designed
to be played in a few short minutes, while taking a break or looking to pass the time.

Links: Website [https://github.com/bluesabre/sgt-launcher], Donate [https://bluesabre.org/donate/]

 Sudoku is a Japanese logic-based puzzle game. The objective is to fill a 9×9 grid with the numbers 1 to
9 so that each column, row, and each of the 3×3 subgrids contain all of the digits from 1 to 9. Each game
starts with a partially completed grid, with many games having only a single solution.

Graphics 
 Document Scanner, also known as Simple Scan, is a utility to scan text or images/photographs and save

them to an image or PDF file.
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 GIMP (GNU Image Manipulation Program) is an image editing application for enhancing and
retouching photos, free-from drawing, as well as image format conversion.

Links: Website [https://www.gimp.org], Documentation [https://www.gimp.org/docs/], Donate [https://
www.gimp.org/donating/]

Alternatives: Krita ( krita [apt://krita]), MyPaint ( mypaint [apt://mypaint]), Adobe Photoshop
[https://www.makeuseof.com/tag/install-adobe-photoshop-linux/]

 Ristretto is an image viewer with basic editing features, slideshow capabilities, and the ability to set an
image as the desktop wallpaper.

Links: Website [https://gitlab.xfce.org/apps/ristretto], Documentation [http://docs.xfce.org/apps/ristretto/
start]

Alternatives: Eye of MATE ( eom [apt://eom]), gThumb ( gthumb [apt://gthumb]), Gpicview

( gpicview [apt://gpicview]), nomacs ( nomacs [apt://nomacs])

Internet 
 Firefox is a mature and stable web browser which can be extended with a wide variety of add-ons.

Links: Website [https://www.mozilla.org/en-US/firefox/new/], Documentation [https://support.mozilla.org/
en-US/home], Donate [https://donate.mozilla.org/en-US/]

Alternatives: Chromium ( chromium-browser [apt://chromium-browser]), Google Chrome [https://
www.google.com/chrome/], Opera [https://www.opera.com/computer/opera], Vivaldi [https://vivaldi.com/
download/], Brave [https://brave.com/download/]

 Pidgin is a multi-platform instant messaging client capable of connecting with XMPP, Google Talk, IRC,
ICQ and more.

Links: Website [https://www.pidgin.im/], Documentation [https://developer.pidgin.im/wiki/Using Pidgin],
Donate [https://imfreedom.org/donate/]

Alternatives: Telegram ( telegram-desktop [apt://telegram-desktop]), Empathy ( empathy [apt://
empathy]), Skype [https://www.skype.com/en/get-skype/], Zoom [https://zoom.us/download]

 Thunderbird is a versatile mail client which can handle multiple email accounts and different identities
simultaneously. Like Firefox, it can also be enhanced with add-ons to extend its functionality.

Links: Website [https://www.thunderbird.net/en-US/], Documentation [https://support.mozilla.org/en-US/
products/thunderbird], Donate [https://donate.mozilla.org/thunderbird/]

Alternatives: Geary ( geary [apt://geary]), Claws Mail ( claws-mail [apt://claws-mail]), Evolution

( evolution [apt://evolution]), Sylpheed ( sylpheed [apt://sylpheed])
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Default Applications

 Transmission is a simple BitTorrent client for downloading and sharing files which also provides a web
interface.

Alternatives: qBittorrent ( qbittorrent [apt://qbittorrent]), Deluge ( deluge [apt://deluge]),
Tixati [https://www.tixati.com/download/linux.html], Fragments [https://flathub.org/apps/details/
de.haeckerfelix.Fragments]

Multimedia 
 Parole is a simple media player that can play video and audio files.

Links: Website [https://gitlab.xfce.org/apps/parole], Documentation [https://docs.xfce.org/apps/parole/
start], Donate [https://bluesabre.org/donate/]

Alternatives: VLC ( vlc [apt://vlc]), SMPlayer ( smplayer [apt://smplayer]), Celluloid ( celluloid
[apt://celluloid]).

Anmerkung

In order to play some proprietary media formats, such as MP3, the ubuntu-restricted-extras is

required ( ubuntu-restricted-extras [apt://ubuntu-restricted-extras]).

 Xfburn is a program for creating audio discs and writing ISO files to CDs and DVDs.

Alternatives: Brasero ( brasero [apt://brasero]), K3b ( k3b [apt://k3b])

Office 
 Atril is a document reader that is capable of opening multiple-page document files, such as PDF, XPS,

ePub, and Comic Books.

Alternatives: Evince ( evince [apt://evince]), Okular ( okular [apt://okular]), Zathura ( zathura
[apt://zathura])

 LibreOffice is an office suite which has programs for word processing (Writer), spreadsheets (Calc),
presentations (Impress), diagrams (Draw), mathematical formulae (Math) and databases. It is a continuation
of Open Office.

Alternatives: Microsoft Office [https://www.makeuseof.com/tag/install-use-microsoft-office-linux/], WPS
Office [https://www.wps.com/linux/], Free Office [https://www.freeoffice.com/en/download/applications],
OnlyOffice [https://www.onlyoffice.com/download-desktop.aspx], GOffice (Abiword, Gnumeric)
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Settings 
Applications listed in this category are also present and organized in  Settings Manager and include
applications to adjust hardware preferences, manage software, change the look and feel of the UI (User
Interface), and configure login settings.

System 
 Gigolo is an easy way to connect to local and remote file systems, such as FTP or SFTP (SSH) connections

and SMB (windows shares).

 GParted is a partition manager that allows you to create, resize, format and delete partitions.

Alternatives: GNOME Disks ( gnome-disk-utility [apt://gnome-disk-utility]), KDE Partition Manager

( partitionmanager [apt://partitionmanager])

Anmerkung

GParted is only present in the live installer, but can be installed after installation ( gparted [apt://
gparted]).

 Task Manager provides a graphical overview of the running applications and shows the percentage of
CPU and RAM that is currently being utilized.

Alternatives: GNOME System Monitor ( gnome-system-monitor [apt://gnome-system-monitor]), MATE

System Monitor ( mate-system-monitor [apt://mate-system-monitor]), LXTask ( lxtask [apt://
lxtask]).

 Thunar is a file manager that allows you to browse the filesystem.

Alternatives: Caja ( caja [apt://caja]), Nemo ( nemo [apt://nemo]), PCManFM ( pcmanfm [apt://
pcmanfm]), Nautilus ( nautilus [apt://nautilus])
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Kapitel 5. Software Management
Software that is readily available to install on Xubuntu is stored in online software repositories which contain
trusted software. Software repositories on Linux are similar to the software catalogs used by desktop app
stores like the Microsoft Store and Mac App Store, or mobile app stores like the Google Play Store and
Apple's App Store.

These repositories store software packages, which are the individual components that collectively make
up the software your computer uses. The software packages are stored in this fashion so that they
can be shared by different programs. Xubuntu's software repositories are organized and maintained by
OS (Operating System) maintainers and contain a large selection of free and open source software. OS
maintainers ensure that the software functions properly and does not contain spyware or viruses.

Xubuntu comes with applications which make it easy for users to install, update, and uninstall software from
repositories.

• Software Center ( gnome-software [apt://gnome-software]) is an app store which is good for new
users because it makes it easy to discover desktop applications. The list of available software can be

expanded with the installation of plugins for the snap package repository ( gnome-software-plugin-
snap [apt://gnome-software-plugin-snap]) and the flatpak package repository ( gnome-software-
plugin-flatpak [apt://gnome-software-plugin-flatpak]).

• Snap Store (install [https://snapcraft.io/install/snap-store/ubuntu#install]) is an app store for the
management of applications that use the snap package management system. Snap applications are
confined for extra security, update automatically, and can run across many different Linux distributions.
The Snap Store is also available as a web interface [https://snapcraft.io/store].

• Synaptic ( synaptic [apt://synaptic]) is a package manager with a GUI (Graphical User Interface) for
users who want more control over package management. It has options to view installation history, view
packages by repository, and lock a package to a particular version.

• apt or apt-get is a CLI (Command-Line Interface) tool for package management that provides similar
functionality to Synaptic and is beneficial for those who don't have access to a GUI or prefer to use
the terminal. For information on the basic apt commands, see the Ubuntu apt documentation [https://
ubuntu.com/server/docs/package-management].

• snap ( snapd [apt://snapd]) is a command-line utility for the management of snap packaged
applications. For information on the basic snap commands, see the Getting started documentation
[https://snapcraft.io/docs/getting-started] and the download and offline install tutorial [https://
snapcraft.io/tutorials/snap-download#1-introduction].

Anmerkung

You will need administrative access to add, update, and remove software and you can only utilize one
package manager at a time for package management. There are additional app stores and package
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Software Management

managers including Flathub [https://flathub.org/], AppImageHub [https://appimage.github.io/],

Ubuntu MATE Software Boutique, AppGrid [https://www.appgrid.org/], Aptitude ( aptitude [apt://
aptitude]).

Using Software Center
You can launch the GNOME Software Center from the  Applications Menu ( Ctrl+Escape) or Application
Finder ( Alt+F3). It will be named Software and is found by default in the Favorites category, so it will be

visible once you open the  Applications Menu.

Once launched, you will be on the Explore tab of the GNOME Software, which allows you to browse the
categories or click the search button in the title bar, to easily find an application by name or keyword. When
you click on an application, you will arrive at its information page, which contains its description, images,
website link, reviews, and other details. On this page you have the option to either install, launch, or remove
the application, as well as write a review.

The other two tabs in the title bar are Installed and Updates. The Installed tab lists all the applications installed
on the system and provides easy access to remove them. The Updates tab shows which applications are
eligible for updating and it also has a Refresh button in the title bar to search for new updates.

Achtung

Einige Anwendungen hängen von der Installation anderer Anwendungen ab, um ordentlich zu
funktionieren. Wenn Sie versuchen, eine Anwendung zu entfernen, die von einer anderen Anwendung
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benötigt wird, werden beide Anwendungen entfernt. Sie werden aufgefordert, zu bestätigen, dass
dies das ist, was Sie möchten, bevor die Anwendungen entfernt werden.

Anmerkung

GNOME Software does not remove the software package dependencies that get installed with an
application. To remove any dependencies that are no longer needed by the system, run sudo apt
autoremove in a terminal. Before agreeing to the removal, check that the packages being marked
for removal are the expected ones.

Software Repositories
The Ubuntu software repositories contain thousands of applications curated from the best FOSS (Free
and Open Source Software) for both entertainment and productivity. Management of these software
repositories and additional ones is possible in the Software & Updates app found in the Settings category

of the  Applications Menu, as well as in the  Settings Manager. It can also be opened through the
Gear button menu in the title bar of GNOME Software or the Application button menu found on the left
corner of the title bar.

On the Ubuntu Software tab, you can enable and disable the main four Ubuntu software repositories, as well
as select the server where the downloaded packages should come from. The Other Software tab allows you
to enable, disable, add, edit, and remove extra online and offline repositories.
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Installing Third-Party Apps
For applications that aren’t available or outdated in the software repositories, users can visit the software
author’s website and download their Linux or Ubuntu installation file. This file will have a .deb file extension
and is a Debian software package. Once downloaded, simply open the file, and it will open in GNOME
Software with the option to install. Alternatively, it can be installed through the GDebi Package Installer
( gdebi [apt://gdebi]).

Some application authors may provide a third-party repository, known as a PPA (Personal Package Archive),
which can be added to your system. Other application authors may provide their software in the form of an
installable Flatpak or as an AppImage, which runs without installation.

Anmerkung

Only download third-party apps from trusted sources in order to limit the risk of getting malware,
junkware, or ransomware. If you’d like to install Windows applications, please see Kapitel 14, Migrating.

Software Updates
In order to keep your system updated and protected from potential security issues, Xubuntu has a software
updates notifier running in the background. It checks for updates once a week and when updates are found,
the Software Updater app will launch.

Anmerkung

To disable the software updates notifier service, disable the Update Notifier entry in the Application
Autostart tab of the Session and Startup app. However, this is not recommended.

Software Updater

To manually check for software updates, you can open the Software Updater found in the Settings category

of the  Applications Menu as well as in the System category of the  Settings Manager. Once opened, it
will query the software repositories, compare the software list against the versions installed on your system,
and present those that can be updated.
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Update Check Settings

You can set how often the Software Updater checks for updates, which updates to check for and what
should happen when updates are found. These settings can be accessed when Software Updater is run
by clicking the Settings... button at the bottom left. Pressing this will open the Software & Updates dialog
with the Updates tab selected.
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Anmerkung

Software Updater will also notify you when a new version of Xubuntu is available. Learn more in the
Kapitel 16, Upgrading.
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Kapitel 6. Settings - Personalization
Similar to other desktop or mobile operating systems, Xubuntu comes with a default look and feel that
some users will prefer to customize to their needs. Unlike Windows, Mac OS and some Linux desktop
environments, Xubuntu comes pre-installed with many customization tools that give users a lot of control.

Xubuntu’s customization settings can be accessed from the Personal category of the  Settings Manager,

the Settings category of the  Applications Menu (Ctrl + Escape), Application Finder (Alt + F3), or the right-
click menu of an object.

Panel
Xubuntu’s default panel layout has a single panel at the top of the screen with the menu, window list, and
notification area. This panel layout can be switched to another bundled panel layout or can be manually
customized.
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Panel Presets

The Panel Profiles settings dialog makes it easy to switch to any of the bundled panel layouts or apply an
imported panel layout. It also makes it easy to save your current panel layout and export it.

• GNOME 2 - This layout is inspired by the default GNOME 2 desktop environment panel layout, which has
a panel at the top and bottom. The top panel has a classic tree menu, places context menu, settings and
browser launchers, and notification area, while the bottom panel has the show desktop button, window
list and workspace switcher.

• openSUSE 15.1 - This is the default layout found in the Xfce edition of openSUSE, which has a single panel
at the bottom with a modern searchable menu, show desktop button, window list, workspace switcher,
and notification area.
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• Redmond - This layout is inspired by Microsoft Windows XP, with a single panel at the bottom that has a
classic menu, windows list and notification area.

• Xfce 4.12 - This is the default Xfce 4.12 layout that contains a panel at the top and bottom. The top panel
has a classic menu, window list, workspace switcher and notification area, while the bottom centered
panel has a show desktop button, user folders button, and various application launchers.

• Xfce 4.14 - This is the default Xfce 4.14 layout and is similar to the Xfce 4.12 panel layout, with the exception
of having a smaller top panel with additional audio, battery and notification indicators.

• Xubuntu 12.04 (Precise) - This was the default panel layout used in Xubuntu’s 2012 LTS release and is
similar to the Xfce 4.12 panel layout, but has an auto-hide panel at the bottom.

• Xubuntu 14.04 (Trusty) - This was the default panel layout used in Xubuntu’s 2014 LTS release and has a
single panel at the top, with a modern searchable menu, window list and notification area.

• Xubuntu 18.04 (Bionic) - This was the default panel layout used in Xubuntu’s 2018 LTS release and is
similar to the Xubuntu 14.04 (Trusty) panel layout, with the addition of audio and notification indicators.

Panel Customization

To make minor changes to Xubuntu’s panel(s), you can do the following:

• Drag an application launcher from the  Applications Menu, Desktop or Application Finder onto the
panel to add it to the panel.

• Right-click an application launcher in the  Applications Menu and select the Add to Panel entry in the
context menu to add it to the panel.

• Right-click on any of the panel items and select the Properties, Move, or Remove entries in the context menu
to customize, move to the desired position, or remove from the panel.

• Right-click on any of the panel items and selecting Panel -> Add New Items... to add a new item to the panel.
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For other changes to panel(s), you will need to open the Panel settings dialog, which is also accessible by
right-clicking on any of the panel items and selecting Panel -> Panel Preferences.... The top section of the
dialog gives access to open the Panel Profiles settings dialog and the ability to select, add and remove
panels. The remainder of settings are broken up across three tabs.

• Display - On this tab, you can set the panel’s width and height, vertical or horizontal orientation, position
on the screen, and hiding behaviour. To move the panel, you will need to uncheck the Lock panel checkbox
and drag it by one of the two handles that appear on either side.
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• Appearance - On this tab, you can set the panel’s transparency, icon size and whether its background is
a color or image.

• Items - This tab allows you to add, arrange, and remove plugins, as well as access plugin properties
through the button bar. It is also possible to rearrange items by dragging with the mouse, and access
properties by double-clicking.

It is possible to install additional panel plugins, also known as panel applets. Panel plugins not listed in the
Add New Items dialog will need to be installed before they can be used. Some of the plugins are listed here
[https://docs.xfce.org/xfce/xfce4-panel/start#external_plugins] and the more popular/useful ones are for

clipboard management ( xfce4-clipman-plugin [apt://xfce4-clipman-plugin]), global menu ( xfce4-
appmenu-plugin [apt://xfce4-appmenu-plugin]), etc.

Users who want a dock similar to the one found on Mac OS and elementary OS can choose from

these docks - Plank ( plank [apt://plank]), DockbarX (PPA [https://launchpad.net/~xuzhen666/+archive/
ubuntu/dockbarx]), Docky, or Cairo Dock. Users who want a Windows 7-like taskbar with window list
buttons can install the DockbarX (PPA [https://launchpad.net/~xuzhen666/+archive/ubuntu/dockbarx])
or Docklike (PPA [https://launchpad.net/~xubuntu-dev/+archive/ubuntu/extras]) panel plugins. Below are
sample layouts customized by Xubuntu users.

Windows 7
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Mac OS

Anmerkung

If you have multiple screens, additional panel configurations will appear on the Display tab, including
the options to configure which display the panel should appear on or whether the panel should span
all monitors.

Menu
The easiest tweak you can make to the  Applications Menu is to customize your Favorites, so you have
easy access to your most important/used applications as soon as you open it. You have the options to:

• Add an application by locating the application either by searching for it by name or by browsing the
categories, right-clicking on it and selecting Add to Favorites from the context menu.

• Remove an application by right-clicking on an application in Favorites and selecting Remove From Favorites
from the context menu.

• Rearrange/reposition an application by left-clicking an application in Favorites and dragging it to the
desired position.
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For options to customize the look and feel of the  Applications Menu, right-click on the menu button
and select Properties in the context menu to launch the Whisker Menu settings dialog. The dialog is divided
into tabs for:

• Appearance - Contains options for how the applications and categories will look, as well as the placement
of the application list, category list, search field, and command buttons.
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• Panel Button - Select whether the Menu button is an icon, a text label, or icon and label, and what that
label should be.

• Behavior - Decide on the feel of the Menu, including whether categories should be selected once the mouse
hovers over them, whether the Menu should stay open even when focus is lost, whether the Recently
Used category should be displayed by default, and whether session commands should have confirmation
dialogs.

• Commands - Enable or disable the appearance of the Settings Manager and session commands in the
command buttons section of the Menu, as well as the appearance of the Edit Applications entry in the
Menu button’s context menu.

• Search Actions - List the various keyword patterns that can be used to extend the functionality of the search
field and make it easy to search other sources like Wikipedia or the file system.
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To customize which applications appear in the  Applications Menu, open the Menu Editor utility, which
is also accessible by right-clicking the Menu button and choosing Edit Applications from the context menu.
Using this editor you can create new application launchers or categories, as well as edit the details of existing
ones, including which categories the application appears in, whether the application will be visible in the
menu, and the icon or name used by the application.

Anmerkung

For more in-depth information on how to use all of those options, consult the MenuLibre [https://
github.com/bluesabre/menulibre/wiki/Usage] online documentation.
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Arbeitsumgebung
The desktop is visible once you login to your account and its background is also present on the login and
lock screens. To access customization options, open the Desktop settings dialog, which is also accessible
by right-clicking a blank area of the desktop and selecting Desktop Settings from the context menu.

Background
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Once the Desktop settings dialog is launched, the Background tab gives you options to choose between a
wallpaper image, a color gradient, a single color, or a combination of wallpaper(s) and color(s) as the desktop
background.

When choosing an image as the background from the wallpaper list, you may choose from the default
selection that comes with Xubuntu or select an image from a different folder by changing the Folder
dropdown. You have the option to set how the wallpaper will fit on the screen in the Style dropdown. The
default is Zoomed, which resizes the image preserving its aspect ratio and cropping the image to fill the
screen. If you have multiple monitors connected, then the dropdown will also have a Spanning screens entry,
to stretch the wallpaper the displays.

If there are multiple images in the wallpaper list, you also have the option to set the background to
automatically cycle through them in an ordered or random sequence. By enabling the Change the background
checkbox, you have several time-based options to choose from. The last option, Chronologically, sets the
wallpapers to appear over evenly timed periods of a day.

Anmerkung

The default selection of wallpapers shipped with Xubuntu includes wallpapers created by the Xubuntu
team for different releases and wallpapers submitted by the community. For more community
contest-winning wallpapers, search for the packages that begin with xubuntu-community-wallpapers
in the Synaptic package manager.
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To set the background as a single color or a two-color gradient, set Style to ‘None’ and then set Color to the
appropriate entry. You can then click on the color buttons next to the dropdown list to open the Select Color
dialog. You have the option to select from the list of color presets, right-click on a color preset to customize
that color, or create a custom color from scratch by pressing the plus button.

If you have multiple workspaces, also known as virtual desktops, you can choose to have the same
background appear across all workspaces or use a different background for each workspace. To use a
different background, uncheck the Apply to all workspaces checkbox,then move the dialog to each workspace
individually and select a different background. This can be done by dragging the window to the left or right
corners of the screen or pressing the keyboard shortcuts Ctrl + Alt + Home or Ctrl + Alt + End. This also is
the case when you have multiple monitors connected, where each display will have the default wallpaper
unless the window is dragged to other displays and the background is changed.

Anmerkung

The easiest way to set an image as the background wallpaper is to right-click the image on the current
workspace or display and select Set as wallpaper from the context menu.

Icons

In the Icons tab of the Desktop settings dialog you can set the properties of the icons that appear on the
desktop, including their sizes, sort arrangement, label font size, click activation behavior, whether or not they
should have tooltips and thumbnails, and which system icons appear by default. The Icon type dropdown
list gives you the option to have desktop icons for files and launchers, minimized application windows, or
no icons at all.

Menus

The Menus tab of the Desktop settings dialog provides customization options for the two menus that can
appear when using the mouse.

• Desktop Menu - This menu appears when right-clicking the desktop. You may choose whether or not this

menu includes the  Applications Menu in a tree hierarchy.

• Window List Menu - This menu appears when middle-clicking the desktop. You may choose whether or
not to display this menu, as well as application and workspace customization options within the menu.

Theming
A desktop theme is used to change the look and feel of the GUI (Graphical User Interface) and can consist
of many things, including the desktop wallpaper, user interface styling and colors, fonts, icons, and sounds.
In Xubuntu, you may change many of these individual components, so your desktop can be as unique as
you like it to be.

The three main theming components that you should know about are:
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• Window Decorations - This is the appearance of the outer section of a window, including the title bar and
window borders. It is also known as the window manager theme.

• UI Controls - This is the appearance of the user interface elements found within the inner section of the
window, such as the buttons, scroll bars, and window background. It is also known as the Gtk theme.

• Icons - This is the icon set used to style the icons found in toolbars and menus, on files and folders, on
application launchers and buttons. It is also known as the Icon theme.
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UI Controls and Icons

Open the Appearance settings dialog and you will be on the Style tab which will allow you to set your UI
(User Interface) controls theme by selecting an entry in the list. If you switch to the Icons tab you will be able
to set your icon theme by selecting an entry in the list. The Fonts tab will allow you to set the default font
used for UI text, as well as setting font rendering options. The Settings tab has options to enable and disable
images in menus and on buttons, as well as change how toolbar entries are styled.
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Anmerkung

Not all icon themes will work well with dark panels and window backgrounds.

If you install applications that use the Qt UI toolkit [https://en.wikipedia.org/wiki/Qt_(software)], such

as Qbittorrent or Clementine, the Qt5 Settings ( qt5ct [apt://qt5ct]) utility will allow you to configure

their theming, while the qt5-style-plugins [apt://qt5-style-plugins] package will use the current
theme on Qt apps.

If you’d like to change the theme of the mouse cursor, open the Theme tab of the Mouse and
Touchpad app.
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Window Decorations and Effects

Once you open the Window Manager settings dialog, you will be on the Style tab which will allow you to set
the window decoration theme, as well as customize the various elements of the title bar. This includes the
alignment and font size used in the title bar text and the arrangement and visibility of the title bar buttons.

Xubuntu doesn't come with many desktop effects, but the Xfce compositor is enabled by default. The Xfce
compositor is used to draw shadows behind windows and panels, as well as set the transparency of window
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decorations and windows in various states. To access these desktop effects, open the Window Manager
Tweaks settings dialog to its Compositor tab.

Anmerkung

If you have a low-end GPU or you don't like the desktop effects mentioned, you can turn off the
compositor by unchecking Enable display compositing or modifying the other settings.

More Themes

If the default selection of themes doesn't satisfy you, you can easily download and install new themes.
Sometimes window decoration and UI control themes will come bundled together as a single Gtk theme,
while Icon themes may also include a mouse cursor theme. You can find new themes in the software
repositories, such as:

• UI themes - Adapta ( adapta-gtk-theme [apt://adapta-gtk-theme]), Arc ( arc-theme [apt://arc-
theme]), Materia ( materia-gtk-theme [apt://materia-gtk-theme])

• Icon themes - Papirus ( papirus-icon-theme [apt://papirus-icon-theme]), Numix Circle ( numix-
icon-theme-circle [apt://numix-icon-theme-circle]), Moka ( moka-icon-theme [apt://moka-icon-
theme])

Additional themes can be found on the Internet, as .deb Debian package files, in PPA software
repositories, on websites like Xfce-look.org [http://xfce-look.org/] and Github.com, or from the theme
author’s website. Here are some popular choices:

• UI themes - Xfce Simple Dark [https://www.xfce-look.org/p/1150488], Mint Mac Dark [https://www.xfce-
look.org/p/1174937/], Matcha [https://github.com/vinceliuice/Matcha-gtk-theme], Plano [https://
www.xfce-look.org/p/1174518/], Pop [https://www.xfce-look.org/p/1299758/], Flat Remix [https://
drasite.com/flat-remix-gtk], Dracula [https://draculatheme.com/gtk/]

• Icon themes - Flat Remix [https://drasite.com/flat-remix], Paper [https://snwh.org/paper/download]

Installing Themes

If you install new themes from the repositories, or through a .deb Debian package file, they will
automatically appear in the relevant lists. If you download a theme from the Internet, you will need to install
the theme before it will appear in the relevant list. Here are three means to install downloaded themes:

• Drag and Drop - With the Appearance settings dialog open to either the Style or Icons tabs, you can drag
and drop a compressed .tar.xz theme file onto the theme list.

• OCS URL - If you are installing themes from Xfce-look.org, you can install the ocs-url [https://
www.pling.com/p/1136805/] installation helper tool and then click the ‘Install’ buttons in the OCS-Install
column on the Files tab of the theme’s page.
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• Manually - Open the compressed UI or Icon theme file and extract its contents into the appropriate folder.
If these directories do not exist, you will need to create them first.

• UI themes -  /home/username/.themes/

• Icon themes -  /home/username/.icons/

Anmerkung

The username part of the folder path should be replaced with your username.

In Linux, files and directories starting with a . (dot) are hidden by default and to unhide them in the
file manager, open the View menu and check the Show Hidden Files entry or alternatively press Ctrl +
H. To unhide them in the file open or save dialogs, right-click in the files list area of the dialog and
select Show Hidden Files from the popup menu.
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Kapitel 7. Settings - Hardware
Your computer consists of a number of components and devices that collectively are known as computer
hardware. This includes internal components, such as the CPU, motherboard, hard disk, graphics card,
sound card, wifi adapter, and bluetooth adapter, as well as external peripheral devices, such as the monitor,
mouse, keyboard, and printer.

Xubuntu configures your hardware automatically with optimal defaults, but there may be occasions when
you need to make changes to these hardware settings. This section provides information on tools to

configure them, which can be accessed from the Hardware category of the  Settings Manager, the Settings
category of the  Applications Menu (Ctrl + Escape), and in the Application Finder (Alt + F3).

Monitor
Whether you have a single screen or multiple monitors, you can easily access their customization options
by opening the Display settings dialog, which is also accessible with the keyboard shortcut Super + P.
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On the General tab, you can change the screen’s resolution, refresh rate, rotation and reflection in the various
drop-down lists. Click the Apply button to try out the changes and a confirmation dialog will appear to let
you confirm or reject the changes. The previous configuration will be restored if you don’t confirm or reject
the changes within 10 seconds.

Anmerkung

Note: To change how fonts are rendered or set a custom DPI text size, see the options in the Fonts
tab of the Appearance settings dialog. To manage monitor power saving options such as when it
should enter power-save mode or how much to lower the brightness after inactivity (only applicable
to laptops), see the options in the Display tab of the Power Manager settings dialog. If you are
experiencing screen tearing when playing videos, you may change the vblank value of the compositor
or modify the xorg config file.

High Resolution

High resolution displays may require specific settings to achieve readability of text and other screen objects.
High-end laptop screens and other ultra-high resolution displays may have high pixel density in a small
form factor. They are commonly referred to as HiDPI (High Dots Per Inch), 4K, UHD, WQHD, QHD, or 1440p
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displays. Some laptops with these types of screens include MacBooks with „Retina Display“, Dell XPS 13,
and ThinkPad X1 Carbon. 4K and 8K UHD TVs may also require customization to make text readable at the
viewing distances typical of these displays.

To improve the visibility of text and objects on these large resolution displays, you can make the following
changes.

• Open the Appearance settings dialog, change to the Settings tab, and change Window Scaling to ‘2x’.

• Open the Window Manager settings dialog and in the Style tab, change to a HiDPI theme like ‘Default-
hdpi’ or ‘Default-xhdpi’.

Multiple Monitors

When you have an external monitor or TV screen connected to your laptop or multiple monitors and/or
screens connected to your desktop, more options will become visible on the General tab of the Display
settings dialog. Select the screen that you wish to change the settings of by selecting it in the preview area
or changing the entry in the screen drop-down list.

One of the additional options presented in a multi-screen setup is the option to rearrange the displays in
the preview area by dragging and dropping them to match how they are physically placed. Additional multi-
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screen options include turning off a screen, setting a monitor as the primary display, mirroring the desktop
on multiple displays, or extending the desktop across both screens.

Anmerkung

Note: With a screen set as the primary display, you can then configure the panels, desktop icons, and
notifications to appear on that screen. Click the information icon next to the Primary Display toggle
button to open the respective setting dialogs.

The Advanced tab provides even more multi-monitor options, including the option to save a display
configuration so that it can be easily applied at a later time. When the Configure new displays when
connected option is toggled, the below Displays mini dialog will appear, providing the most common display
configurations, as well as any user-saved display configurations. The keyboard shortcut Super + P will open
this dialog in a multi-monitor setup and clicking the ‘Advanced’ button opens the Display settings dialog.

The Automatically enable profiles when new displays are connected toggle will apply a user-saved display
configuration when the connected displays match the displays found in a saved display configuration.

Colors

For color-sensitive work, the Color Profiles settings dialog allows you to install and manage color profiles
for your displays, printers, and scanners. In order for color profiles to be used, the required daemon will
need to be installed and running in the background:

• xiccd [apt://xiccd] for display profiles

• cupsd [apt://cupsd] for printer profiles

• saned [apt://saned] for scanner profiles

To calibrate your display, you will need to install DisplayCAL [https://displaycal.net/#download], GNOME

Color Manager ( gnome-color-manager [apt://gnome-color-manager]) with a ColorHug device, or a
similar tool. If you would like to add a „night-mode“ or „blue-blocker“ feature, that will automatically
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transition the color temperature of the display throughout the day, you can install RedShift ( redshift
[apt://redshift]).

Keyboard
During the installation of Xubuntu, options to select the keyboard’s language and layout were presented and
applied. In order to make changes to these and additional keyboard options, open the Keyboard settings
dialog.

67

apt://redshift
apt://redshift


Settings - Hardware

The Behavior tab provides options for the Num Lock key state, key repeat speed and delay, as well as
text cursor blinking speed. The Application Shortcuts tab allows you to manage the keyboard shortcuts for
the launching of applications. The Layout tab provides options to select the keyboard model and manage
keyboard languages and layouts. With multiple keyboard layouts present, you also have the option to set a
keyboard shortcut to cycle through the keyboard layouts.

Anmerkung

Note: To easily determine which keyboard layout is currently active and switch between them, you can
add the Keyboard Layouts plugin to the panel. For additional non-application keyboard shortcuts, see
the Keyboard tab of the Window Manager settings dialog. For control over the behavior of various
power related keyboard buttons, see the General tab of the Power Manager settings dialog.

Mouse
Pointer devices like a mouse, trackpad, trackball, or graphical tablet are automatically detected and
configured during startup or when plugged in. If you want to make changes to the default options and
behaviour of a device, open the Mouse and Touchpad settings dialog.
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The Devices tab allows you to select each individual device from the Device drop-down list and adjust their
individual options. This includes whether it is enabled, as well as its button arrangement, scroll direction,
pointer speed, and trackpad sensitivity. If the selected device is a trackpad that is using the Synaptics driver,
a Touchpad tab will appear next to the Buttons and Feedback tab with options to enable and disable the
trackpad while typing, tap to click, as well as edge and two-finger scrolling. A Tablet tab will appear when a
device is detected to be using the Wacom driver.

The Behavior tab has global settings that affect all pointer devices, including how sensitive the drag and drop
and double click operations are. The Theme tab allows you to set the cursor theme.
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Einige Touchpads werden möglicherweise als normale Mäuse erkannt, obwohl Sie in Wirklichkeit Touchpads
sind. In diesem Fall wird das Touchpad-Gerät nicht in den Mauseinstellungen verfügbar sein. Lesen Sie die
Touchpads [https://help.ubuntu.com/community/SynapticsTouchpad]-Seite Im Ubuntu Community Wiki für
mehr Informationen zu Touchpads.

Sound
Sound in Xubuntu is processed through the PulseAudio sound server, which is capable of performing
advanced operations on sound data going to and from your hardware devices. Making changes to the sound
preferences can be done through the multimedia keyboard keys, the sound plugin in the notification area
of the panel or the PulseAudio Volume Control settings dialog.

Sound Applet

The panel sound plugin gives you easy access to raise, lower and mute the volume of devices, select from
multiple input and/or output devices when applicable, as well as control the playback of various audio
and video media players. The Audio mixer... entry at the bottom of the plugin popup window will open the
PulseAudio Volume Control settings dialog.

It is possible to adjust the output volume by using the mouse scrollwheel above the sound plugin icon.
To customize whether multimedia keys are enabled, if a notification appears when the output volume is
changed, and which media players will appear in the plugin popup window, right-click on the sound plugin.
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Sound Dialog

The PulseAudio Volume Control settings dialog, which is found in the Multimedia category of the , has
various tabs to view and configure sound settings.

• Playback - You can adjust the volume of system sounds, as well as set the volume, channel balance, and
output device of each running application.

• Recording - Lists applications that are currently recording and allows the adjustment of the volume and
input device.

• Output Devices - Lists audio output devices and allows the adjustment of their output source, volume,
and latency.
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• Input Devices - Lists audio input devices and allows the adjustment of their input source, volume, and
latency.

Anmerkung

Note: To enable system sounds, open the Appearance settings dialog, change to the Settings tab

and enable ‘Enable event sounds’. Install one of the sound themes, such as FreeDesktop ( sound-
theme-freedesktop [apt://sound-theme-freedesktop]), Yaru ( yaru-theme-sound [apt://yaru-
theme-sound]) or Pop ( pop-sound-theme [apt://pop-sound-theme]). If you use a sound theme
other than FreeDesktop, open Settings Editor, change to xsettings in the left side pane, and under
the Net category, edit the SoundThemeName value to the name of the sound theme.

Device Drivers
A device driver is a computer program that controls a particular device connected to a computer. It acts
as a bridge to allow the operating system and other software to communicate with the hardware. A device
driver gets activated when the device is found on a computer or when the device is plugged in.

Most device drivers are installed by default in Xubuntu, so everything should work automatically when
you plug it in. Device drivers can either be open source or proprietary and are provided by the hardware
manufacturer or the open source community.

Open Source Drivers

Xubuntu is a Linux distribution and the foundational part of the operating system is the Linux kernel. The
Linux kernel contains thousands of device drivers and the majority of them are open source, which allows
kernel developers to modify them. To update these open source drivers, you only need to update the Linux
kernel, which is one of the components updated through the Software Updater.

When hardware manufacturers do not release sufficient technical details for their hardware, it is not possible
to create a complete open source driver, so the hardware may not have an open source driver or will have an
open source driver with limited functionality. Some open source drivers are reverse-engineered to provide
an alternative to the hardware manufacturer’s proprietary driver, but these will not be as feature complete.

Proprietary Drivers

Some hardware manufacturers do not provide open source drivers for their hardware, but instead provide a
proprietary driver, also known as a closed-sourced driver or binary blob. Without these proprietary drivers or
firmware, the components and devices may not function properly or at all. These drivers will normally need
to be installed manually, as they can’t be included in the kernel. They will primarily be drivers for graphics
cards, wireless adapters, and processor firmware, with the most common ones being:

• NVidia Graphics Driver - Though there is a reverse engineered open source driver, called ‘Nouveau’, it
does not have re-clocking and power management features to make it run optimally for gaming and may
cause issues on legacy cards not supported by the current version of the driver.
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• AMD Graphics Driver - The open source ‘RadeonSI’ driver is recommended for gaming and general home-
use, while the proprietary ‘AMDGPU-PRO’ driver is recommended for workstation users requiring features
not implemented in the open source driver, primarily OpenCL 2.0 support.

• Intel Wireless Driver - The wireless driver is open source but requires a proprietary firmware to run.

• Broadcom Wireless Driver - The wireless driver is open source but requires a proprietary firmware to run.

• AMD/Intel Microcode - These are stability and security updates to the processor firmware and are
recommended to be enabled.

Anmerkung

Note: If you enabled the ‘Install third-party software for graphics and Wi-Fi hardware and
additional media formats’ checkbox during installation, then the required proprietary drivers will be
automatically installed and enabled.

Managing Proprietary Drivers

To view and manage which proprietary devices are used on your system, you can open Additional Drivers,
which will open the Software & Updates settings dialog to the Additional Drivers tab.

Some computers may not have any devices listed because either the open source drivers are fully supported
or because there are no proprietary drivers for the devices. If there are any proprietary drivers listed, you
will have the options to:

• enable them if the device does not currently have an open source driver.
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• switch between the open source and proprietary drivers.

• switch between different versions of the proprietary driver.

• disable them if they are causing problems or you would just like to turn them off.

Anmerkung

Note: Proprietary drivers are stored in the restricted software repository. If this repository wasn’t
enabled during installation, you will need to enable it to see entries listed in the dialog. You can do so
by switching to the Ubuntu Software tab and enabling the ‘Proprietary drivers for devices (restricted)’
checkbox.

Anmerkung

You will need to be connected to the internet to install drivers. You will be prompted to enter your
password when changing the driver and may need to restart your computer to finish enabling or
disabling the driver.

Anmerkung

Caution: It will generally be rare to find device drivers on a hardware manufacturer’s website. If you
wish to install a driver manually, please make a backup of your data and system as a precaution and
be careful to follow the instructions correctly.

74



Kapitel 8. Settings - Connectivity

Netzwerkverbindungen
Whether you are connected to a computer on your home’s LAN (Local Area Network) or a computer
kilometers away on the Internet, the status of your network connection is always visible to you in the
notification area of the panel. Network customization settings are available in the Advanced Network
Configuration settings dialog, which is accessible from the Hardware category of the  Settings Manager,

the Settings category of the  Applications Menu (Ctrl + Escape), and in the Application Finder (Alt + F3).

Network Applet

When there is no access to the network, either because networking has been disabled or a connection to
the network hasn’t been established, a disconnected Network icon will appear on the panel to indicate this
status. When you are connected, the icon will vary depending on which connection type the network is using.
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Clicking on the Network icon will open a menu that displays the connectivity status to the Ethernet and
Wi-Fi networks, as well as listing any Wi-Fi networks that are in range. If you are connecting using a wired
ethernet cable, it will connect automatically, whereas if you select a Wi-Fi network in the menu that wasn’t
previously connected, a dialog box may open if a password is needed.

The Connect to Hidden Wi-Fi Network... menu entry will allow you to connect to a Wi-Fi network that is hiding its
network name by entering the network name and, if required, the password. The Create New Wi-Fi Network...
menu entry will allow you to create a new wireless hotspot from your computer. The entry will open a dialog
where you can set the network name, security method and key to be used.
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Selecting the Connection Information menu item will open a dialog that displays information about the
connection devices, including their MAC addresses, drivers, and speed, as well as IP address information in
both IPv4 and IPv6. Selecting the Edit Connections... menu entry will open the network configuration dialog.

To disconnect from a network, select the Disconnect menu entry under the appropriate connection type.
Enabling and disabling the wired and wireless connections is possible by selecting the Enable Networking or
Enable Wi-Fi checkboxes. Enable Networking will enable or disable all wired and wireless connections, while
Enable Wi-Fi is limited to enabling or disabling wireless connections.

Network Dialog

To make configuration changes to network connections, select the Edit Connections... entry in the Network
applet’s menu or open the Advanced Network Configuration settings dialog through the  Applications
Menu, Application Finder, or  Settings Manager.
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The dialog lists existing network connections categorized by connection type. The bottom of the dialog has
buttons to add and remove network connections or edit the selected network connection. When editing a
network connection, you can set features such as the connection’s name, whether it should use a VPN, MAC
address clone, security options, proxy options, IP address options, and DNS servers.

If you click the Add a new connection button at the bottom of the Network Connections dialog, a dialog
will appear asking you to select the connection type. The connection type list includes hardware types,
such as DSL and Mobile Broadband, virtual types, such as Bond and Bridge, and VPN (Virtual Private
Network) types. If the VPN connection type you wish to create isn’t listed, you will need to install its plugin,

with OpenVPN ( network-manager-openvpn-gnome [apt://network-manager-openvpn-gnome]),
WireGuard (PPA [https://launchpad.net/~wireguard/+archive/ubuntu/wireguard], wireguard [apt://
wireguard]) and OpenConnect ( network-manager-openconnect-gnome [apt://network-manager-
openconnect-gnome]) being popular options. To be able to connect to certain networks, you may need
connection details that will be supplied to you by your network administrator or ISP (Internet Service
Provider).
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Anmerkung

Unfortunately, dialup modems are not supported by the NetworkManager. To read about
connecting with a dialup modem, please refer to the Ubuntu community wiki’s Dialup modem How-
to [https://help.ubuntu.com/community/DialupModemHowto].

Sharing Your Connection With Another Computer

If you are connected to a network connection by Ethernet cable or by cellular and have a Wireless adapter
connected to your computer or laptop, you can share your connection with another computer. To set up the
wifi hotspot, the simple method is to select the Create New Wi-Fi Network... menu entry through the Network
panel applet. Alternatively open the Network Connections settings dialog and either add or modify a Wi-
Fi connection. In the connection properties dialog, switch to the IPv4 Settings tab and change Method to
Shared to other computers from the drop-down list.

Bluetooth
Bluetooth is a popular wireless technology that allows us to easily pair our computers, mobile phones, and
tablets to input and output peripherals, like headsets, speakers, mice, keyboards, and printers. If a bluetooth
adapter is connected to your computer, a bluetooth applet will appear in the notification area of the panel. If
the bluetooth icon is dimmed, then the bluetooth adapter is disabled and hovering the mouse over the icon
will also show this status in the tooltip. Clicking the Bluetooth icon will display a menu with action options,
such as changing the adapter’s status and sending a file to a device, as well as configuration options, such
as adapter and device settings.
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The top menu item will allow you to enable or disable the bluetooth adapter depending on its current status.
The Set Up New Device... menu item will open a wizard dialog to assist you in connecting your new bluetooth
device. The Adapters... menu entry will open a dialog where you can set the adapter’s visibility and broadcast
name. The Devices... menu entry will open the Bluetooth Manager settings dialog, which is also accessible

through the  Applications Menu, Application Finder, or  Settings Manager.

80



Settings - Connectivity

The settings dialog will list all of the bluetooth devices that have been connected to your computer. To
connect to new devices, click the Search button and visible devices will appear in the list. Select the new device
and either pair or connect to it through the Pair button in the toolbar or the items in the right-click context
menu. Additional options to rename, trust, remove, or send a file to a device can be found in the toolbar or
context menu. To make changes to the adapter settings, open the Adapter menu and select Preferences.

Mit Servern verbinden
To connect to various types of servers, you can use  → System → Gigolo. To connect to a server, follow the
steps below:

• Go to Actions → Connect

• Wählen Sie die passende Art des Dienstes und geben Sie die Verbindungsinformationen ein

• Klicken Sie den Verbinden-Knopf; falls Sie sicht mit einem Server verbinden, welcher eine Anmeldung
erfordert, werden Sie aufgefordert, ein Passwort einzugeben.

Upon successfully connecting to the server, an icon labeled with connection details will appear in the Gigolo
window. To bookmark connections, right-click on a connection and select Create Bookmark. In the Edit
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Bookmarks dialog, you can name the bookmark and set other options, including the option to auto-connect.
Once you are done, click OK to create the bookmark.

Anmerkung

The Windows Share username should be in the format DOMAIN\username

Anmerkung

In order to connect to Samba networks (Windows shares) using the Thunar File Manager, you will

need to have the package gvfs-backends installed.
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Kapitel 9. Drucken und Scannen

Drucken
The majority of consumer printers are automatically supported by Xubuntu, as it uses the CUPS (Common
UNIX Printing System) back-end. This includes support for driver-less WiFi/wired network printing with
printers that support IPP Everywhere and Apple AirPrint. If your printer is not immediately supported by

Xubuntu you may need to install additional software, such as Gutenprint ( printer-driver-gutenprint
[apt://printer-driver-gutenprint]) and IPP-USB (install [https://software.opensuse.org//download.html?
project=home%3Apzz&package=ipp-usb]). Gutenprint extends CUPS by providing support for printers seen
less often in end-user consumer settings, while IPP-USB is a more robust replacement to the default

installation of the ippusbxd package. Normally CUPS and Gutenprint support is better adapted to
Xubuntu than what will be available from the printer manufacturer.

Managing Your Printer

Printer management can be done in the Printers settings dialog, which is accessible from the Hardware
category of the  Settings Manager, the Settings category of the application  Applications Menu (Ctrl
+ Escape), and in the Application Finder (Alt + F3).

The Printers settings dialog allows you to add a new local printer (a printer directly connected to your
computer through a USB, serial or printer port) or network printer (a printer connected on your network
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or a printer shared on the network through another computer). It also allows you to modify listed printers’
settings, such as renaming how they are labeled on your system, restarting, or disabling them. You can also
share a printer with other computers on your network thereby making it a network printer. Depending upon
the make and model of your printer, you can also check your printer’s consumables, such as toner or ink
as well as paper, or send test print jobs.

Add Printer

Setting up a new local printer should be as easy as plugging it into your computer and powering it on. The
printer should be automatically detected and configured. Once it is successfully detected, a printer icon will
appear in the notification area of the panel and a notification popup will appear with the text Printer is ready
for printing.

If your printer was not detected, you will need to follow these steps:
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• Open the Printers settings dialog.

• Click the Add button in the toolbar or Server → New → Printer in the menu to open the New Printer dialog.

• Select the appropriate Printer, Port, URI, Protocol or Network Printer entry in the Devices list on the left
of the dialog. If your printer is not visible, you may need to click on the triangle next to „Find Network
Printer“ to expand the list of printers on your network.

• Where applicable, fill in any relevant details into the text fields and/or dropdown lists on the right of the
dialog and then click the Forward button.

• If you are adding a local printer, your computer will search for it and install its drivers. If you are installing a
network printer, you will go through additional steps of selecting the printer manufacturer, printer model
and driver.

• You will then be prompted to enter a short name, description, and location of the printer.

• Press the Apply button to finalize the configuration of the printer.

• You will be prompted with a dialog asking Would you like to print a test page?

• If you press the Print Test Page button, a test page will print and you can verify if it printed correctly or
you can press Cancel. Either way, your printer is ready to print.

If you are experiencing problems adding a printer with the steps above, you can try using the CUPS browser-
based interface. It can be accessed at http://localhost:631/. Click the Administration menu item at the top
of the page for options to add and find new printers. Do not make any changes in the Printers settings
dialog or other system printer management utilities until you are finished using the CUPS browser-based
interface. You may need to restart CUPS for it to reflect any changes that you make directly in the browser-
based interface.

Anmerkung

If the printer is directly connected to a Windows machine on your network, choose the Windows Printer
via SAMBA entry from the Devices list. If you do not know the protocol or details of your network printer,
you should consult the printer’s manual or ask your network administrator.

Search the OpenPrinting database [https://wiki.linuxfoundation.org/openprinting/database/
databaseintro] or check the Community Help Printer page [https://help.ubuntu.com/community/
Printers] for information on your printer.

Share Printer

If you want to share your local printer with other computers on your network:

• Open the Printers settings dialog.
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• Click Server → Settings in the menu.

• Enable the Publish shared printers connected to this system checkbox.

• Click the OK button.

Then go to your secondary Xubuntu installation and open the Printers settings dialog. Click the Add button in
the toolbar, then expand the Network Printer option. The shared printer should appear below as the sharing
computer’s IP address. You may need to first search for the IP address using the Find Network Printer option.

Management Software

If you have an HP (Hewlett Packard) printer and would like additional software to manage it, you can install

the HP Linux Imaging and Printing (HPLIP) GUI utilities ( hplib-gui [apt://hplip-gui]). These utilities include

the HPLIP Toolbox application which will be found in the Settings category of the  Applications Menu and

the Others category of the  Settings Manager. On supported inkjet printers, you will be able to monitor
ink levels, check printer status, change page size and print quality, as well as clean the printer heads. On
supported laser printers you will be able to monitor toner level, check printer status, change page size,
and manage print quality. For all-in-one (multi-function) devices, you will be able to change fax settings and
functionality. For more information about HPLIP click here [https://developers.hp.com/hp-linux-imaging-
and-printing/features].
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Printer Support

The OpenPrinting database stores information about printers, their drivers, and how well they are supported
under Linux. If you are not sure about how well a printer is supported in a Linux environment check that
database. It is also a good database to check before buying a new printer.

Printer Drivers

If your printer doesn’t work automatically or you’d like to install the printer drivers and utilities from the
printer manufacturer, here are some links to assist.

HP [https://developers.hp.com/hp-linux-imaging-and-printing], Canon [https://www.usa.canon.com/
internet/portal/us/home/support/product-finder/support-printers], Brother [https://support.brother.com/
g/s/id/linux/en/index.html], Epson [https://epson.com/Support/wa00821], Xerox [https://
www.support.xerox.com/], Lexmark [http://support.lexmark.com/index?
page=driverSupport&locale=en&userlocale=EN_US]
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Scannen
Similar to Xubuntu’s support for printers, it also has plug and play support for many scanners, as many
of them today come as part of multi-function devices. Scanner support on Linux is provided by the SANE
project which maintains a list of supported scanners [http://www.sane-project.org/sane-backends.html].
Additional scanner support can be achieved with the installation of SANE-airscan (install [https://github.com/
alexpevzner/sane-airscan]), which allows driver-less network scanning with scanners that support Apple
AirScan (eSCL) and Microsoft WSD.

Using your Scanner

To begin using your scanner, open the Document Scanner or Simple Scan app, which is accessible from

the Graphics category of the  Applications Menu (Ctrl + Escape) and in the Application Finder (Alt + F3).
Follow the next steps to scan a document, picture/image, etc.:

• Connect your scanner and power it on.

• Place what you want to scan on the scanner flatbed or feeder.

• Close the lid if you have a lid.

• Click the arrow to the right of the Scan button and choose the type of media you are scanning, Text or
Photo.

• Click the Scan button to begin your scan.
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No Scanners Detected

Es gibt zwei Gründe, weshalb Sie diese Meldung erhalten könnten:

• Your scanner is not automatically supported, which includes most parallel port scanners and Lexmark All-
in-One printer/scanner/faxes.

• Ihr Scannertreiber wird nicht automatisch geladen.

Möglicherweise können Sie einen Treiber installieren oder einige Konfigurationsdateien anpassen, damit
der Scanner funktioniert. Fragen Sie dazu im Ubuntu-Forum [http://ubuntuforums.org/] oder auf AskUbuntu
[http://askubuntu.com/] um Hilfe.

Anmerkung

To get some scanners working, you may need to plug the scanner in after the computer has booted.
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Manuelle Installation eines Scanners

There are some scanners that have incomplete drivers from the SANE project. They can sometimes be used,
but not all the features may work. For these scanners:

• Install the libsane-extras [apt://libsane-extras] package.

• Run pkexec mousepad /etc/sane.d/dll.conf at the command line to open the SANE driver file for
editing.

• Aktivieren Sie den richtigen Treiber für Ihren Drucker, in dem Sie das Zeichen # vor dem Namen des
Treibers entfernen. Es kann sein, dass Sie im Internet suchen müssen, welcher Treiber der richtige ist.

• Speichern Sie die Datei und öffnen Sie Simple Scan. Wenn alles gut geht, funktioniert ihr Scanner nun.
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Kapitel 10. User Management
For security reasons, administrative tasks in Xubuntu can only be performed by users with special privileges.
The first user account created during installation will, by default, be able to perform administrative tasks.

When you run an application that requires administrative privileges, you will be asked to enter your
password. This helps protect your system from malicious activity and lessens the chance that you will
accidentally change the way your system works.

Each time you type your password in a terminal session, it will be remembered for 15 minutes, so that you
do not have to type it again.

Anmerkung

Benutzer müssen Mitglied der »sudo«-Benutzergruppe sein, um administrative Aktionen durchführen
zu dürfen. Informationen, wie man die Gruppen verändern kann können unten gefunden werden.

Benutzer und Gruppen
When Xubuntu is installed, only one user account is created. If multiple users use the computer, it is
highly encouraged to create separate user accounts for everyone. This allows users to have their individual
settings, files and access rights.

To modify the users or groups on your system, navigate to  →  Settings Manager → Users and Groups.

Anmerkung

Sie benötigten Systemverwaltungsrechte, um Änderungen an Benutzern und Gruppen vorzunehmen.

Benutzer verwalten

So fügen Sie einen neuen Benutzer hinzu:

• Klicken Sie auf den Hinzufügen–Knopf

• Geben Sie Ihr Passwort ein

• Geben Sie den Name und Benutzername ein.

• Klicken Sie auf den OK–Knopf

Wenn Sie einem Benutzer Systemverwaltungsrechte für das System geben möchten:

• Den Benutzer auswählen, dessen Kontentyp Sie ändern möchten und auf den Knopf Ändern … klicken

• Geben Sie Ihr Passwort ein wenn Sie dazu aufgefordert werden
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• Wählen Sie die Administrator–Option (oder wählen Sie Desktop-Benutzer, um dieses rückgängig zu machen)

• Drücken Sie OK um die gewählten Änderungen anzuwenden.

Tipp

For more fine-grained access control, click the Advanced Settings button in the User Settings dialog,
enter your password, click the User Privileges tab and from there select or deselect the desired options.

Um einen Benutzer aus dem System zu entfernen, wählen Sie den zu löschenden Benutzer und klicken Sie
den Knopf Löschen.

Gruppen verwalten

Um eine neue Gruppe hinzuzufügen:

• Klicken Sie den Gruppen verwalten-Knopf

• Klicken Sie auf den Hinzufügen–Knopf

• Geben Sie Ihr Passwort ein

• Wählen Sie einen Namen für die neue Gruppe und wenn Sie möchten, ändern Sie den vorgegebenen Wert
für die Gruppenkennung

• Sie können nun auch die Gruppenmitglieder aus der Liste auswählen

• Klicken Sie auf den OK–Knopf

Um eine Gruppe aus dem System zu entfernen, klicken Sie auf den Knopf Gruppen verwalten, wählen Sie
die Gruppe, die sie löschen möchten und klicken Sie den Löschen-Knopf.

Ihre persönlichen Informationen anpassen
Mugshot ist ein leichtgewichtiges Werkzeug zur Benutzerkonfiguration, welches es Ihnen, auf einfache
Weise erlaubt das Profilbild und die Benutzerdetails, für Ihr Benutzerprofil und alle unterstützen
Anwendungen, einzustellen.

To launch Mugshot navigate to  →  Settings Manager → About Me.

Um ihr Profilbild zu ändern, verwenden Sie die Bild-Schaltfläche auf der linken Seite der Oberfläche, wählen
Sie eine der Auswahlmöglichkeiten und folgen Sie den Anweisungen.

Anmerkung

Mugshot requires the installation of gstreamer1.0-tools [apt://gstreamer1.0-tools] package to
use the Capture from camera... feature.
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Füllen Sie die Textfelder mit den benötigten persönlichen Daten aus und klicken auf Anwenden. Wenn Sie
Änderungen anwenden und zusätzlich Pidgin und/oder LibreOffice installiert haben, werden Sie gefragt,
die Änderungen dort ebenfalls zu übernehmen.

Warnung

Wenn die persönlichen Daten in den Textfeldern Vorname und Nachname von den existierenden
Werten in der Datei /etc/passwd abweichen, werden Sie gebeten, als Sicherheitsmaßnahme ihr
Passwort einzugeben, um ungewollte Änderungen an ihren persönlichen Daten zu verhindern.

Read more at the Mugshot [https://wiki.bluesabre.org/doku.php?id=mugshot-docs] official documentation.
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Kapitel 11. Hardware-Geräte
Ihr Rechner besteht aus einer Anzahl miteinander verbundener Geräte, welche zusammen als Hardware
bezeichnet werden.

Normalerweise konfiguriert Xubuntu ihre Hardware automatisch, aber in einigen Fällen müssen Sie selbst
Ihre Hardware konfigurieren. Dieser Bereich gibt ihnen Informationen zu Werkzeugen, mit denen Sie Ihre
Hardware konfigurieren können.

Eingeschränkte Treiber

Warum sind manche Treiber eingeschränkt?

Eingeschränkte Treiber sind Treiber für Ihre Hardware, welche nicht frei verfügbar oder Open Source sind.

Die meisten Geräte (Hardware) an Ihrem Rechner sollten ordentlich mit Xubuntu funktionieren. Diese Geräte
haben wahrscheinlich freie Treiber, was bedeutet, dass die Treiber von den Xubuntu-Entwicklern angepasst
und Probleme von diesen behoben werden können.

Einige Hardware hat keine freien Treiber, meistens weil der Hardwarehersteller keine Details der Hardware
veröffentlicht hat, welche es möglich machen würden, solch einen Treiber zu entwickeln. Diese Geräte
können unter Umständen eingeschränkt oder gar nicht funktionieren.

Aktivierung von eingeschränkten Treibern

Falls ein eingeschränkter Treiber für ein bestimmtes Gerät verfügbar ist, kann er installiert werden,
damit das Gerät ordentlich funktioniert, oder um neue Funktionen hinzuzufügen. Zum Beispiel kann die
Installation von eingeschränkten Treibern für bestimmte Grafiken dazu führen, dass Sie fortgeschrittenere
Grafikeffekte verwenden können.

Einige Rechner haben keinerlei Geräte, welche eingeschränkte Treiber verwenden können, entweder
weil alle Geräte von uneingeschränkten Treibern vollständig unterstützt werden oder weil es noch keine
eingeschränkten Treiber für das Gerät gibt.

If any drivers are available for your hardware they will be installable from the Software and Updates
application:

• Go to  → Settings → Additional Drivers

• Falls notwendig werden Sie dazu aufgefordert, das Systemverwaltungspasswort einzugeben.

• Sie werden eventuell zu einem Neustart aufgefordert, um die Installation abzuschließen.
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Deaktivieren eingeschränkter Treiber

Wenn ein eingeschränkter Treiber Probleme verursacht oder Sie ihn einfach deaktivieren möchten, folgen
Sie bitte folgender Vorgehensweise:

• Go to  → Settings → Additional Drivers

• Finden Sie den Treiber, den Sie deaktivieren möchten und klicken den Deaktivieren-Knopf.

• Sie werden aufgefordert werden, ihr Passwort einzugeben.

Anmerkung

Möglicherweise muss Ihr Rechner neu gestartet werden, um die Deaktivierung des Treibers
abzuschließen.

Festplatten und Partitionen

Überprüfen, wie viel Festplattenspeicherplatz verfügbar ist

A simple way to check available disk space is to launch Thunar. There are several ways to do this:

• Go to  → Accessories → File Manager

• Führen Sie einen Doppeklick auf dem Symbol Dateisystem oder Persönlicher Ordner auf dem Schreibtisch
aus.

• Klicken Sie auf den persönlichen Ordner in der Orte-Leiste

Die Statusleiste am unteren Rand des Fensters zeigt den freien Speicherplatz für das aktuelle Laufwerk oder
Medium an. Wenn Sie mehr als ein Laufwerk eingehangen oder verbunden haben, können Sie diese in der
Seitenleiste anklicken und werden dann den freien Speicher für das entsprechende Laufwerk sehen.

Wie kann ich Speicherplatz freigeben?

Es gibt einige einfache Wege, um mehr Festplattenspeicher zu erhalten:

• Leeren Sie den Papierkorb, indem Sie mit der rechten Maustaste auf das Papierkorb-Symbol auf dem
Schreibtisch oder in der Starterleiste und Papierkorb leeren Trash wählen.

• Remove software packages that you no longer use.

• Delete files that you no longer need. You can install the GNOME Disk Usage Analyzer from GNOME
Software to find which files are taking up the most space.

Warnung

Seien Sie vorsichtig, keine Dateien zu löschen, die sie noch benötigen!
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Ein Laufwerk partitionieren

You can use GParted (GNOME Partition Editor) to partition storage devices. Install GParted from GNOME
Software and then go to  →  Settings Manager → GParted to start the partition editor.

Warnung

Be careful when altering disk partitions, as it is possible to lose your data if you delete or change the
wrong partition.

Warnung

Altering disk partitions can take some time. Do not assume that GParted has hung or crashed while
it is working.

Anmerkung

Falls es notwendig ist, das installierte System auszuhängen um mit den Änderungen die Sie
durchführen möchten fortzufahren, müssen Sie von einer Live-CD/Live-USB-Stick aus arbeiten.

Speicherplatz für eine neue Partition freigeben

Um eine neue Partition innerhalb eines bereits partitionierten Gerätes zu erstellen, müssen Sie zuerst eine
existierende Partition verkleinern. Wenn Sie schon genügend freien Speicher haben, fahren Sie im Abschnitt
„Erstellen einer neuen Partition“ fort. Wenn nicht, folgen Sie den Anweisungen im nächsten Abschnitt:

• Wählen Sie das zu partitionierende Gerät aus der Auswahlliste in der rechten oberen Ecke des
Hauptfensters.

• Eine Liste von Partitionen erscheint im Hauptfenster. Wählen Sie die Partition, deren Größe Sie ändern
möchten und wählen Sie Partition → Aushängen

• Um die Größe einer Partition zu ändern wählen Sie Partition → Größe ändern/Verschieben. Der Größe ändern/
Verschieben-Dialog wird angezeigt. Sie können das Eingabefeld Anschließender freier Speicherplatz (MiB)
verwenden, um zu wählen wie viel freier Speicherplatz hinter der Partition frei gegeben werden soll,
oder Vorhergehender freier Speicherplatz (MiB) um Speicherplatz vor dieser Partition freizugeben. Alternativ
können Sie den Schieberegler verwenden um die Partitionsgröße anzupassen.

• Klicken Sie auf Größe ändern

• Um die Änderungen anzuwenden, klicken Sie auf Bearbeiten → Alle Operationen ausführen

Erstellen einer neuen Partition

Um eine neue Partition zu erstellen:

• Wählen Sie das zu partitionierende Gerät aus der Auswahlliste in der rechten oberen Ecke des
Hauptfensters.
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• Eine Liste der Partitionen wird erscheinen. Wählen Sie die Partition mit dem Namen nicht zugeteilt,
rechtsklicken Sie auf ihr und klicken Sie auf Neu

• Wählen Sie aus der Auswahlliste Dateisystem: den gewünschten Dateisystemtyp.

• Falls gewünscht, geben Sie eine Beschreibung für die Partition im Feld Bezeichnung:  ein.

• Klicken Sie den Knopf Hinzufügen.

• Um die Änderungen anzuwenden, klicken Sie auf Bearbeiten → Alle Operationen ausführen

Formatieren einer Partition

Um eine Partition zu formatieren, machen Sie folgendes:

• Wählen Sie das zu partitionierende Gerät aus der Auswahlliste in der rechten oberen Ecke des
Hauptfensters.

• Es wird eine Liste der Partitionen angezeigt. Wählen Sie die gewünschte Partition und wählen Sie Partition
→ Aushängen.

• Wählen Sie die Partition, welche Sie formatieren möchten und wählen Sie Partition → Formatieren als und
wählen Sie aus der Liste den Dateisystemtyp aus, mit dem die Partition formatiert werden soll.

• Um die Änderungen anzuwenden, klicken Sie auf Bearbeiten → Alle Operationen ausführen

Speichermedien ein- und aushängen

Wenn Sie einen Wechseldatenträger mit Ihrem Rechner verbinden, muss der Datenträger eingehängt
werden, damit Sie auf die Dateien auf dem Datenträger zugreifen können.

Um herauszufinden, wie Sie Speichergeräte manuell und/oder automatisch einhängen und aushängen
können, lesen Sie auf der Ubuntu Community Wiki-Seite für den mount-Befehl [https://help.ubuntu.com/
community/Mount] nach.

Wenn Sie Dateien auf einen Wechseldatenträger kopieren, werden Sie nicht immer direkt auf das Gerät
geschrieben. Stattdessen werden Sie häufig in einer Warteschlange gespeichert, so dass sie alle später (aus
Effizienzgründen) auf einmal auf das Gerät geschrieben werden können. . Ausführung des Befehls sync
kann erzwingen, dass ausstehende Daten auf Wechseldatenträger geschrieben werden. Wenn Sie das Gerät
trennen bevor alle Dateien übertragen wurden, könnten Sie die Dateien verlieren. Um dies zu verhindern,
müssen Sie einen Wechseldatenträger immer aushängen, bevor Sie ihn entfernen.

Laptops
Einstellungen zur Energieverwaltung

Vielleicht möchten Sie die Energieverwaltungseinstellungen Ihres Laptops anpassen, um die
Batterielebensdauer zu verlängern und Energie zu sparen.
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• Go to  →  Settings Manager → Power Manager

• Ändern Sie die Einstellungen wie gewünscht

• Änderungen werden sofort angewandt

Tipp

When your laptop is running on battery, one of the biggest drains on power is the display. Turning
the brightness of the display down could improve battery life significantly; many laptops allow you to

do this by pressing Fn+F7 (or other marked key) several times.

Touchpads

Die meisten Laptops haben ein Touchpad, um den Mauszeiger zu steuern. Es gibt viele Arten, das
Verhalten des Touchpads zu ändern; die grundlegenden Touchpad-Einstellungen können auf folgende
Weise konfiguriert werden:

• Go to  →  Settings Manager → Mouse and Touchpad

• Wählen Sie das Touchpad in der Auswahlliste Gerät:.

• Hier können Sie die Einstellungen für das Touchpad nach Ihren Wünschen ändern. Änderungen werden
sofort übernommen.

Anmerkung

Einige Touchpads werden möglicherweise als normale Mäuse erkannt, obwohl Sie in Wirklichkeit
Touchpads sind. In diesem Fall wird das Touchpad-Gerät nicht in den Mauseinstellungen verfügbar
sein. Lesen Sie die Touchpads [https://help.ubuntu.com/community/SynapticsTouchpad]-Seite Im
Ubuntu Community Wiki für mehr Informationen zu Touchpads.

Bereitschaft und Ruhezustand
Um Energie zu sparen, können Sie ihren Rechner in einen von vielen Energiesparmodi versetzen, wenn Sie
Ihn gerade nicht benutzen:

• Einen Rechner in Bereitschaft zu versetzen ist wie ihn schlafen zu legen. Der Rechner ist immer noch
eingeschaltet und all Ihre Arbeit ist weiterhin geöffnet, er verbraucht aber wesentlich weniger Strom. Sie
können den Rechner dann durch Drücken einer Taste oder Klicken der Maus wieder aufwecken.

• Den Rechner in den Ruhezustand zu versetzen bedeutet, den Rechner vollständig auszuschalten, wobei
der aktuelle Zustand (wie gerade geöffnete Dokumente) gesichert wird. Wenn Sie nach dem Versetzen in
den Ruhezustand den Rechner wieder einschalten, sollte alle Ihre Arbeit wiederhergestellt werden wie sie
vor dem Ruhezustand war. Während des Ruhezustandes des Rechners wird keine Energie verbraucht.
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• Resuming is bringing the computer out of a power saving mode and back into normal operation. You can
resume the computer from being suspended by pressing a keyboard button or by clicking the mouse.
You can resume from hibernation by pressing the power button on your computer.

Anmerkung

Bitte beachten, dass der Ruhezustand per Voreinstellung in Xubuntu deaktiviert ist und nicht als
Option in irgendeinem Menü auftaucht. Um das von der Befehlszeile aus zu umgehen, bitte folgendes
lesen „Ruhezustand aktivieren“.

You can manually put your computer into a power-saving mode by pressing  →  Log Out and then
pressing the appropriate button.

Anmerkung

Einige Rechner haben möglicherweise Probleme, in bestimmte Energiesparmodi zu wechseln. Die
beste Art, auszuprobieren, ob Ihr Rechner einen Energiesparmodus unterstützt, ist auszuprobieren
in diesen Modus zu wechseln und zu prüfen, ob er sich verhält wie Sie es erwarten. Stellen Sie
immer sicher, dass Sie wichtige Dokumente speichern, bevor Sie in den Bereitschaftsmodus oder
Ruhezustand wechseln.

Bereitschaft oder Ruhezustand funktionieren mit meinem Rechner
nicht korrekt

Manche Rechner können mit Xubuntu nicht korrekt in den Bereitschaft- oder Ruhezustand versetzt werden.
Wenn das bei Ihrem Rechner der Fall ist, treten eventuell einige der folgenden Symptome auf:

• Der Rechner schaltet sich nicht aus, nachdem Sie ihn in den Ruhezustand versetzt haben.

• Wenn Sie Ihren Rechner einschalten, nachdem Sie ihn in den Ruhezustand versetzt haben, werden Ihre
zuvor geöffneten Programme nicht wieder hergestellt.

• Der Rechner wacht nicht mehr auf, nachdem Sie ihn in Bereitschaft versetzt haben.

• Einige Programme oder einige Hardwarekomponenten arbeiten nicht mehr richtig, nachdem der Rechner
aus dem Tiefschlaf oder dem Ruhezustand aufgewacht ist.

Wenn Sie irgendeines dieser Probleme haben, sollten Sie einen Softwarefehler auf Launchpad [http://
launchpad.net/] berichten. Diese Probleme werden hoffentlich in einer folgenden Version von Xubuntu
behoben. Sollte Ihre Hardware nach Bereitschaft oder Ruhezustand nicht richtig arbeiten, starten Sie Ihren
Rechner neu. Sollte ein Programm nicht richtig funktionieren, versuchen Sie es zu schließen und wieder neu
zu öffnen.

Warnung

Stellen Sie sicher, dass Sie alle Ihre offenen Dokumente gesichert haben, bevor Sie den Ruhezustand
oder den Bereitschaftsmodus ausprobieren.
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Ruhezustand aktivieren

Um den Ruhezustand bei Xubuntu einzuschalten und zu verwenden, machen Sie folgendes:

• Install the pm-utils [apt://pm-utils] package from GNOME Software.

• Auf der Befehlszeile bitte folgendes eingeben: sudo pm-hibernate.

• Geben Sie Ihr Passwort ein.

• Um den Rechner aus dem Ruhezustand zu wecken, drücken Sie den Einschaltknopf.

Ich sehe seltsame Muster auf dem Bildschirm, wenn ich meinen
Rechner in den Ruhezustand versetze

Ihr Bildschirm kann ein Schwarz-Weiß-Muster anzeigen gleich nachdem Sie den Ruhezustand aktivieren.
Dies ist für gewöhnlich nichts Besorgniserregendes, sondern einfach die Reaktion der Grafikkarte mancher
Rechner auf die Einleitung des Ruhezustands. Sollte der Rechner dieses Muster für eine längere Zeit
anzeigen ohne sich auszuschalten, könnten Sie ein Problem mit dem Ruhezustand haben. Gehen
Sie zu „Bereitschaft oder Ruhezustand funktionieren mit meinem Rechner nicht korrekt“ für nähere
Informationen.

Mäuse und Tastaturen
When you install Xubuntu, you are given the option of selecting your keyboard type and language. During
the installation, your pointing devices should be automatically detected and configured. If you want or need

to change the settings of any of these devices after installation, you can do so by going to  →  Settings
Manager → Mouse and Touchpad or  →  Settings Manager → Keyboard.

Die Einstellungen für Mäuse und Touchpads beinhalten:

• Button orientation

• Pointer speed and sensitivity

• Double-click sensitivity

• Cursor theme

Einige der Optionen zur Konfiguration der Tastatur beinhalten:

• State of the Num Lock key on startup

• Key repeat speed and delay

• Cursor blinking speed
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• Application keyboard shortcuts

• Keyboard layout and language

Tipp

Falls Sie eine Maus an einem Laptop verwenden, der auch ein Touchpad besitzt, können Sie das
Verhalten der beiden einzeln ändern, indem Sie das entsprechende Gerät in der Auswahlliste Gerät:
auf dem Reiter Geräte auswählen.
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Kapitel 12. File Management
Xubuntu comes with Xfce's file manager, Thunar. For simplicity's sake, it will be referred to as the File

Manager from now on. Load it from  → Accessories → File Manager or by double-clicking the Home or File
System icons on your desktop.

Navigation
The File Manager's default view consists of a shortcut pane on the left side, the main area on the right, and a
pathbar above the main area. The shortcut pane provides shortcuts to different folders on your system. The
first shortcut under PLACES takes you to your home directory (/home), the directory where all your personal
data and data from the applications you use are stored, and has the name of the current user.The File System
shortcut under DEVICES will takes you to the root (/) of the filesystem. You may want to explore it a bit, even
though it may be confusing if you are new to Linux. Just click on the different folders and see what's inside.
When you're done, return to your home directory by clicking on the top shortcut.

Anmerkung

Sie können Ihre eigenen Verknüpfungen hinzufügen, indem Sie die Ordner einfach auf die
Verknüpfungsfläche ziehen. Hierdurch können Sie schnell auf wichtige Ordner zugreifen!

Anmerkung

When using Thunar you will, in general, only have read rights to files you see while browsing under
the File System shortcut.

The main area will always display the contents of the current folder. Double-click on folders to enter them,
and right-click on files/folders to get a pop-up window offering you some choices of what to do with them.
Select multiple files by dragging a rectangle over them with the mouse. Alternatively, select one file, hold
down the Shift key, and increase/decrease the selection using the arrow keys.

To easily see the path you took to get to the current directory, you can change the default View options.
From the File Manager menu, select View → Location Selector → Pathbar Style. Now you can click on any pathbar
icon to change to the directory it represents. Note that right-clicking on pathbar icons will also bring up a
pop-up window with some options.

Anlegen und Löschen von Dateien und Ordnern
To create a new document, right-click on some empty space in your home directory and select Create
Document → Empty File from the pop-up menu. The File Manager will prompt you for a name. Just go with
the suggested name for now. After this, you will see the new file in your home directory. Right-click on it
and choose Properties. This will show you some details about the file. Right-click on the file once more and
choose Move to Trash to remove it. The file will be put into the Trash.
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Anmerkung

If you ever want to undo the deleting of a file, open Trash, right-click the file and click Restore.

To create a new folder, right-click on the empty space, and choose Create Folder. You will be prompted for

a name. Type something and hit Enter. You will see this new folder in your home directory. Double-click
on it to enter it. To rename or remove the folder, right-click on it and choose the appropriate option from
the pop-up menu.

Kopieren
Um Dateien auf ihrem Rechner zu kopieren und zu verschieben, klicken Sie und Ziehen Sie die Dateien und
Ordner einfach auf andere Ordner.

Removable Drives
When inserting CDs, USB sticks or other removable media into your computer, or inserting removable
devices like a music player, Xubuntu should automatically detect the new device. For example, after inserting
a CD into your optical drive, you will see a new shortcut in the left pane of the File Manager representing
the CD. Clicking on it will open the CD in the main area, just like clicking on a regular folder. To remove the
CD, right-click on the shortcut, and choose Eject. The same applies for any other removable media.

Anmerkung

Please note that pressing the eject button on your CD drive may not work. This may be surprising
to some users, but it is in fact the expected behavior. Before the CD can be ejected, it needs to be
properly „released“ (unmounted) by the system. To remove a CD, always right-click on its shortcut
and choose Eject.

Thunar anpassen
There are many ways to customize the File Manager. If you do not like the way the icons are displayed,
choose View → View as Detailed List to have the contents of the current directory displayed as a list.

You can have the File Manager display a location bar instead of the pathbar by selecting View → Location
Selector → Toolbar Style. If you prefer a tree view in the left pane, choose View → Side Pane → Tree.

Finally, you can add Custom Actions, which can add useful options to the menu. Many custom
actions can be found at the Ubuntu Wiki Thunar Custom Action [https://help.ubuntu.com/community/
ThunarCustomActions] page.

For more choices, explore the options under Edit → Preferences.
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Kapitel 13. Multimedia-Anwendungen

Musik

Musik hören

You can use Parole Media Player to listen to music on your computer. Parole Media Player will open audio
files when they are double-clicked. Alternatively, you can right click on audio files and select Open with Parole
Media Player.

Um einige beliebte Audioformate wie MP3 abzuspielen, müssen Sie zusätzliche Software installieren. Leider
kann diese Software aufgrund rechtlicher Einschränkungen nicht in Xubuntu vorinstalliert werden.

Achtung

Read „Eingeschränkte Formate“ before following the instructions below. There are some legal issues
that you should be aware of.

Portable Musikabspielgeräte

Xubuntu funktioniert mit den meisten portablen Musikabspielgeräten, inklusive iPods. Normalerweise
müssen Sie nur das Gerät an Ihren Rechner anschließen und anschließend die Dateiverwaltung benutzen,
um manuell die Lieder von dem Gerät und auf das Gerät zu kopieren.

Anmerkung

Neuere iPods (6. Generation und neuer) funktionieren nicht automatisch mit Xubuntu. Hierfür müssen
Sie das Gerät zunächst initial mit iTunes synchronisieren.

Wenn Sie ein portables Musikabspielgerät haben, was auch in der Lage ist Fotos und Videos wiederzugeben,
ist möglicherweise Banshee mit guter Unterstützung für solche Geräte eine gute Wahl. iPod Eigentümer
können auch spezialisierte Anwendungen, wie GPixPod, gtkpod und ideviceinstaller wählen.

Filme, DVDs und Videos
Sie können Filme und Videoclips mit dem Parole Medienspieler anschauen.

DVDs abspielen

Um DVDs abzuspielen müssen Sie einige zusätzliche Software installieren. Leider kann die DVD-Wiedergabe
in Xubuntu, aufgrund rechtlicher Einschränkungen in einigen Ländern nicht standardmäßig unterstützt
werden.
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Achtung

Read „Eingeschränkte Formate“ before following the instructions below. There are some legal issues
that you should be aware of.

Um DVDs abspielen zu können, machen Sie Folgendes:

• Install the libdvdnav4 [apt://libdvdnav4], libdvdread4 [apt://libdvdread4] and gstreamer1.0-
plugins-ugly [apt://gstreamer1.0-plugins-ugly] packages.

• Legen Sie eine DVD in ihr Laufwerk. Sie sollte automatisch in dem Parole Medienspieler geöffnet werden.

• If you would like to play encrypted DVDs, open  → Accessories → Terminal Emulator and type the

following into the Terminal followed by the Enter key: sudo apt-get install libdvd-pkg Take
note of the information provided in the terminal during installation, particularly with regard to upgrades
to the package.

• Once libdvd-pkg is finished run sudo dpkg-reconfigure libdvd-pkg The installation of libdvdcss2
will now complete.

Videos abspielen

Parole-Medienspieler unterstützt die meisten Arten von Videos. Falls Sie versuchen, eine nicht
unterstützte Videodatei abzuspielen, weist der Parole-Medienspieler Sie auf eine fehlende Erweiterung
hin. Dann können Sie dieses Erweiterung installieren, indem Sie den Anweisungen im Assistenten folgen.
Anschließend müssen Sie eventuell den Parole-Medienspieler neu starten.

Wenn Sie Schwierigkeiten haben ein Video in ihrem Browser abzuspielen, dann unterstützt Parole
Medienspieler die meisten Videotypen. Um ein Video in Parole Medienspieler zu öffnen, rechtsklicken Sie
das Video und wählen Sie Mit »Parole Medienspieler« öffnen.

Eingeschränkte Formate

Einige Videoformate, wie Adobe Flash, QuickTime und Windows Media Video sind proprietär und daher kann
keine Unterstützung für diese Formate in Xubuntu vorinstalliert werden. Sie müssen zusätzliche Software
installieren um diese Formate abspielen zu können.

In order to play the most common proprietary formats in Parole Media Player or Firefox, install the

xubuntu-restricted-extras [apt://xubuntu-restricted-extras] package.

CDs und DVDs brennen
Sie können Ihre eigenen CDs und DVDs erstellen, indem Sie Dateien mit dem CD- or DVD-Brenner ihres
Computers ein leeres Medium beschreiben.
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Multimedia-Anwendungen

Xfburn ist die vorinstallierte Anwendung um diese Aufgaben durchzuführen. Xfburn erlaubt es, auf
einfache Weise Musik-CDs, CDs und DVDs mit Daten oder Datenträger-Abbildern zu brennen und wieder
beschreibbare Medien für einen neuen Brennvorgang zu leeren.

In order to launch Xfburn, go to  → Multimedia → Xfburn.

Nachdem das Programm gestartet ist, können Sie eine CD-R(W) oder DVD-R(W) einlegen und können dann
die Aktion auswählen, die sie durchführen möchten (Datenzusammenstellung, Audio-CD, etc.).
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Kapitel 14. Migrating
Migration von Windows
A quick Windows-Xubuntu dictionary

Windows: Programme hinzufügen/entfernen

Xubuntu:  → Software
Windows: Systemsteuerung

Xubuntu:  →  Settings Manager for personal preferences  → System (menu) for additional
configuration
Windows: Windows Explorer

Xubuntu:  → Accessories → File Manager
Windows: Meine Dokumente

Xubuntu:  /home/username/

Windows-Programme unter Linux
It is possible to run Windows applications under Xubuntu. Three popular choices are:

• Wine [http://winehq.org/] ( wine [apt://wine]), the Windows emulator. Wine allows running Windows
applications without having to install a Windows operating system. Refer to the Wine AppDB [http://
appdb.winehq.org/] to find out which applications will run on Wine and the Wine documentation [http://
www.winehq.org/help/] for FAQ's and user support.

• PlayOnLinux [https://www.playonlinux.com/] is an easy to use frontend for Wine, which makes it easy to
install popular Windows applications.

• VirtualBox [https://www.virtualbox.org/], Virtualisierungssoftware. Sie können ein Windows-
Betriebssystem und dafür geeignete Anwendungen in die virtuelle Maschine, die von VirtualBox verwaltet
wird, installieren. Beachten Sie bitte, dass die 3D Unterstützung in VirtualBox noch immer etwas
unzuverlässig ist. Um mehr über VirtualBox und Virtualisierung zu erfahren folgen Sie VirtualBox end-
user documentation [https://www.virtualbox.org/wiki/End-user_documentation].

Tipp

Sowohl Wine als auch VirtualBox sind in den Software-Paketquellen verfügbar.

Windows-Netzwerke und Linux
Auf Windows-Netzwerkfreigaben kann unter Xubuntu auf einfache Weise zugegriffen werden:

•  → Accessories → File Manager, where you can browse publicly visible shares by clicking on the Network
item in the sidebar. Alternatively, you can browse a remote file system by going to Go → Open Location...
and entering smb://computername/sharename.
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Migrating

•  → System → Gigolo, which allows you to save bookmarks and manage remote file systems. To connect,
click the first toolbar button. Select Windows Share from Service Type, then enter the remote share's details.

If some options are not available or do not work, ensure that the gvfs-backends [apt://gvfs-backends]
is installed.
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Kapitel 15. Troubleshooting

Lösen von Netzwerkproblemen
Bevor Sie irgendeine Problemlösung ausprobieren, stellen Sie sicher, dass die Netzwerkverbindungen
aktiviert sind:

• Klicken Sie auf das NetworkManager-Symbol im Benachrichtungsbereich

• Aktivieren Sie Netzwerk aktivieren

• Aktivieren Sie Funknetzwerk aktivieren

Falls Ihre Netzwerkverbindung immer noch nicht funktioniert:

• Für kabelgebundene (Ethernet) Verbindungen, lesen Sie bitte „Allgemeine Problemlösungen“

• Für drahtlose Verbindungen, lesen Sie bitte sowohl „Allgemeine Problemlösungen“ als auch
„Problembehebung bei drahtlosen Netzwerken“

• Falls ihre Probleme mit der Netzwerkverbindung immer noch nicht gelöst sind, lesen Sie „Fortgeschrittene
Problemlösungen“

Allgemeine Problemlösungen

Wenn ihre Netzwerkverbindung nicht ordentlich funktioniert, gibt es ein paar Werkzeuge, um das Problem
zu analysieren.

Informationen über die aktuelle Verbindung erhalten

Um Informationen über Ihre Netzwerkverbindung und -geräte zu erhalten gibt es zwei Möglichkeiten:

• Verwendung von NetworkManager

• Klicken Sie auf das NetworkManager-Symbol

• Select Connection Information. If this is disabled, it is likely there is no active connection. Try using the
ip command to find out more.

• Jede aktive Verbindung hat einen eigenen Reiter, auf dem Sie die relevanten Informationen finden
können.

• Using ip

• Open a terminal (  → Accessories → Terminal Emulator), type the command ip address then press

the Enter key.
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• ip will show you extensive information about your connection, including logical or connection name(s)
(e.g. enp3s0) in the first row, IP address in the inet row and the MAC address for your device in the link/
ether row

Überprüfen, ob eine Verbindung korrekt funktioniert

Eine verlässliche Methode zur Prüfung, ob eine Verbindung ordnungsgemäß funktioniert, ist es, einen
anderen Rechner im Netzwerk oder Internet zu »pingen«.

To check if your computer is connected to the Internet, open a terminal (  → Accessories → Terminal
Emulator), type the command ping -c 3 www.xubuntu.org then press the Enter key.

Der Rechner wird dann dreimal versuchen, www.xubuntu.org zu erreichen und die Ergebnisse anzeigen.
Die Ping-Statistiken zeigen die Anzahl der gesendeten Pakete, die Anzahl der empfangenden Pakete, den
Prozentsatz der verlorenen Pakete und die Gesamtdauer an.

• 0% Paketverlust zeigt an, dass der Rechner mit dem Internet verbunden ist

• Mehr als 0% aber weniger als 100% Paketverlust zeigt an, dass Ihr Rechner eine schlechte Verbindung
zum Internet oder einen schlechten Funkempfang hat.

• 100% Paketverlust deuten darauf hin, dass der Rechner eine sehr schlechte Verbindung hat oder mit
einem Access Point oder Router verbunden ist, welcher nicht mit dem Internet verbunden ist.

If you get an error message that says „www.xubuntu.org can not be found“ or „unknown host“, then your
computer is probably not connected to the Internet or is unable to reach a Domain Name System (DNS)
server.

Problembehebung bei drahtlosen Netzwerken

Dieser Abschnitt behandelt häufige Probleme bei der Verwendung von drahtlosen Netzwerkgeräten. Mehr
Informationen gibt es in dem Community Help Wiki [https://help.ubuntu.com/community/WifiDocs].

Anmerkung

Bitte beachten Sie, dass die Schritte in dieser Problemlösungsanleitung so vorgesehen sind, dass Sie
diese in der gezeigten Reihenfolge ausführen, es sei denn, Sie werden auf ein anderes Unterkapitel
verwiesen.

Prüfen Sie, dass das Gerät eingeschaltet ist

Viele Funknetzwerkgeräte (WLAN-Adapter) können ein- oder ausgeschaltet werden. Suchen Sie nach einem
Hardware-Schalter oder einer Funktionstaste auf der Tastatur, um das Funknetzwerkgerät einzuschalten.

Wenn das Gerät eingeschaltet ist, fahren Sie im nächsten Kapitel fort.
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Prüfen Sie, ob das Gerät erkannt wird

Open a terminal (  → Accessories → Terminal Emulator), type the command sudo lshw -C network, then

press the Enter key. You will see some output, along with the words CLAIMED, UNCLAIMED, ENABLED or
DISABLED.

• CLAIMED zeigt an, dass der Treiber geladen ist, aber nicht funktioniert. Fahren Sie fort mit „Nutzung von
Windows–WLAN–Treibern“.

• UNCLAIMED zeigt an, dass kein Treiber geladen ist. Fahren Sie fort mit „Nutzung von Windows–WLAN–
Treibern“.

• ENABLED zeigt an, dass der Treiber geladen ist und funktioniert. Fahren Sie fort mit „Die Verbindung zum
Router prüfen“.

• DISABLED zeigt an, dass der Treiber installiert, aber deaktiviert ist. Fahren Sie fort mit „Prüfen Sie, dass
das Gerät eingeschaltet ist“.

Nutzung von Windows–WLAN–Treibern

Xubuntu unterstützt ein System mit dem Namen NDISWrapper. Dieses ermöglicht die Verwendung von
Windows-WLAN-Treibern unter Xubuntu. Um NDISWrapper zu verwenden:

• Besorgen Sie den Windows-Treiber für Ihr Netzwerkgerät und finden Sie die Datei mit der Dateiendung
.inf

• Install the ndisgtk [apt://ndisgtk] package

• Go to  →  Settings Manager → Windows Wireless Drivers

• Wählen Sie Installiere neuen Treiber

• Wählen Sie den Ort ihrer Windows .inf –Datei und klicken Sie auf Installieren

• Klicken Sie auf OK

Die Verbindung zum Router prüfen

Open a terminal (  → Accessories → Terminal Emulator), type the command iwconfig then press the

Enter key.

Wenn die ESSID für Ihren Router angezeigt wird, gibt es möglicherweise ein Problem mit der ACPI-
Unterstützung. Starten Sie Xubuntu mit der Option pci=noacpi.

Fortgeschrittene Problemlösungen

Die folgenden Methoden zur Problemlösung sind etwas technischer. Bitte versuchen Sie diese nur, wenn
obige Methoden fehlgeschlagen sind.
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IP-Adressen-Vergabe prüfen

Open a terminal (  → Accessories → Terminal Emulator), type the command ip address then press the

Enter key. If there is an IP address displayed, continue to „Die Domain Name Server (DNS) überprüfen“.

From the terminal enter the following command, replacing enp3s0 with the name of the connection shown
in the output from the ip address command: sudo dhclient enp3s0

• Wenn Sie eine Nachricht erhalten, die sagt verbunden mit xxx.xxx.xxx.xxx, fahren Sie fort mit „Die
Domain Name Server (DNS) überprüfen“

• Wenn nicht, starten Sie den Rechner neu

Die Domain Name Server (DNS) überprüfen

Open a terminal (  → Accessories → Terminal Emulator), type the command nmcli device show then

press the Enter key. Look for the entries under IP4.DNS

To check if the listed DNS works, open a terminal (  → Accessories → Terminal Emulator), type the command

dig xubuntu.org then press the Enter key. If you see the word NOERROR in the header section of the
output, your DNS is working.

If there are no DNS settings listed, contact your Internet Service Provider (ISP), and find out your primary
and secondary domain name servers.
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Kapitel 16. Upgrading
Xubuntu aktualisieren

Neue reguläre Xubuntu-Veröffentlichungen erscheinen alle 6 Monate und Long Term Support (LTS)-
Veröffentlichungen alle 2 Jahre. Aktuell werden reguläre Veröffentlichungen 9 Monate lang unterstützt und
LTS-Veröffentlichungen 3 Jahre lang.

Die Aktualisierungsverwaltung wird Sie informieren, wenn eine neue Version für Ihren Upgradeweg zum
Download verfügbar ist. Um den Upgradeweg zu ändern, lesen Sie „Wechseln des Upgradewegs“.

Upgrades usually take a while to complete. Typically, around 1000 MB of packages must be downloaded and
installed, although the actual figure depends on how many packages are already installed on your computer.

Upgrade auf die nächste verfügbare Version

• Go to  →  Settings Manager → Software Updater and wait for the list of available updates to be
downloaded

• Wenn eine neue Version von Xubuntu verfügbar ist, erscheint am Fenster oben eine Box, in der dies
mitgeteilt wird.

• To upgrade to the next available release, save all of your open documents and click the Upgrade button

in  →  Settings Manager → Software Updater

Anmerkung

Wenn Sie keine Benachrichtigung bekommen, noch die Version sehen können, auf die Sie
aktualisieren möchten, gehen Sie bitte zu „Wechseln des Upgradewegs“.

Wechseln des Upgradewegs

Es gibt zwei mögliche Upgradewege, denen Sie folgen können: Entweder nur Upgrades auf folgende LTS-
Versionen oder jede mögliche Zwischenversion.

Wenn Sie sich entschließen dem LTS-Upgradeweg zu folgen, werden Ihnen alle zwei Jahre neue Versionen
angezeigt. Wenn Sie sich für den Weg aller möglichen Zwischenversionen entschlossen haben, werden Sie
alle 6 Monate informiert und müssen diese Upgrades auch tatsächlich durchführen, bis Sie die nächste LTS-
Version erreicht haben.

Wenn Sie sich dazu entschließen Ihren Upgradeweg zu ändern, so können Sie dies, wenn Sie eine LTS-
Version betreiben. Um dies zu veranlassen, wählen Sie eine der folgenden Möglichkeiten:

• Navigate to  → Software → Software & Updates and select the Updates tab. In the Updates tab, select
either For any new version or For long-term support versions from the Notify me of a new Ubuntu version
dropdown menu depending on your choice.
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• Open the  → Accessories → Terminal Emulator and run sudo edit /etc/update-manager/release-
upgrades and change the line starting with prompt= to prompt=normal (for all releases) or prompt=lts
(for LTS releases) depending on your choice

Anmerkung

Wenn Sie eine Zwischenversion installiert haben, auf die nicht unmittelbar eine LTS-Version folgt, dann
sollten Sie den Upgradeweg nicht auf "Nur LTS-Versionen" wählen.

Achtung

Das Upgrade einer LTS-Version auf irgendeine andere als eine andere LTS-Version führt zum Verlust
der Langzeitunterstützung.

Upgrade auf die Entwicklerversion
Warnung

Entwicklerversionen leiden oft unter unvollständigen Paketdateien und anderen Problemen.
Installieren Sie eine Entwicklerversion nur dann wenn Sie sich in der Lage sehen solche Probleme
selbst auszuräumen oder Sie das Xubuntu-Team durch Testen und das Geben von Rückmeldungen
unterstützen möchten.

Anmerkung

Sie müssen die letzte reguläre Version verwenden, um auf die derzeit in Entwicklung befindliche
Version aktualisieren zu können.

If you would like to install and test the latest development version of Xubuntu before it is released,
run update-manager -c -d at the command line. This will allow you to upgrade to the current
development release. Please consider getting involved [http://xubuntu.org/contribute/qa] with reporting
usage of development versions and associated packages.

Benachrichtigung über neue Xubuntu-Versionen

Dieser Abschnitt der Aktualisierungsverwaltung beschäftigt sich mit der Art und Wiese, auf die Sie über
neue Versionen benachrichtigt werden. Sie haben drei Auswahlmöglichkeiten:

• For any new version - You will get notifications of all new releases, once in 6 months.

• For long-term support versions - You will get notifications of new Long-term Support (LTS) releases, once
in 2 years.

• Never - You will not get notifications of new releases.

Tipp

Die Auswahl für LTS-Benachrichtigungen ist die empfohlene Option, speziell wenn Sie Xubuntu auf
einem Produktiv-Computer nutzen, für den maximale Stabilität erforderlich ist.
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Warnung

It is not recommended to user the Never setting. Unless you remember to manually upgrade often
enough, this will leave you with an unsupported system. Additionally, you will be missing out on bug
fixes, updates for potential security problems and hardware support improvements.
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Anhang A. Anwendungsliste
Anzeigename: Catfish-Dateisuche
Paketname: catfish
Kurzbeschreibung: Dateisuchwerkzeug, welches über die Befehlszeile konfigurierbar ist
Anzeigename: Dokumentenbetrachter
Paketname: atril
Kurzbeschreibung: Dokumentenbetrachter (PostScript, PDF)
Anzeigename: Taschenrechner
Paketname: mate-calc
Kurzbeschreibung: Taschenrechner
Anzeigename: Zeichentabelle
Paketname: gucharmap
Kurzbeschreibung: Unicode-Zeichenpalette und Schriftenanzeiger
Anzeigename: LibreOffice Calc
Paketname: libreoffice-calc
Kurzbeschreibung: Tabellenkalkulation
Anzeigename: LibreOffice Writer
Paketname: libreoffice-writer
Kurzbeschreibung: Textverarbeitung
Anzeigename: Mousepad
Paketname: mousepad
Kurzbeschreibung: Einfache, Xfce-orientierte Textbearbeitung
Anzeigename: PulseAudio-Lautstärkeregelung
Paketname: pavucontrol
Kurzbeschreibung: PulseAudio-Lautstärkeregelung
Anzeigename: Simple Scan
Paketname: simple-scan
Kurzbeschreibung: Einfaches Scan-Programm
Anzeigename: Anwendungsfinder
Paketname: xfce4-appfinder
Kurzbeschreibung: Auf Ihrem System installierte Anwendungen finden und starten
Anzeigename: Programm ausführen
Paketname: xfce4-appfinder
Kurzbeschreibung: Ein Programm ausführen
Anzeigename: Wörterbuch
Paketname: xfce4-dict
Kurzbeschreibung: Wörterbucherweiterung für die Xfce4-Leiste
Anzeigename: Prozessverwaltung
Paketname: xfce4-taskmanager
Kurzbeschreibung: Prozessverwaltung für die Xfce-Arbeitsumgebung
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Anwendungsliste

Einstellungsverwaltung
Anzeigename: Menübearbeitung
Paketname: menulibre
Kurzbeschreibung: Menüansichtsbearbeitung
Anzeigename: Über mich
Paketname: mugshot
Kurzbeschreibung: Leichtgewichtige Anwendung für Benutzereinstellungen
Anzeigename: Netzwerkverbindungen
Paketname: network-manager-gnome
Kurzbeschreibung: Programmiergerüst zur Netzwerkverwaltung
Anzeigename: Zusätzliche Treiber
Paketname: software-properties-gtk
Kurzbeschreibung: Drittanbieter- und proprietäre Gerätetreiber konfigurieren
Anzeigename: Anwendungen & Aktualisierungen
Paketname: software-properties-gtk
Kurzbeschreibung: Quellen zum Installieren von Anwendungen und Aktualisierungen einrichten
Anzeigename: Drucker
Paketname: system-config-printer-gnome
Kurzbeschreibung: Grafische Oberfläche zur Einrichtung von Druckern

Hinter den Kulissen
Paketname: gvfs-backends
Kurzbeschreibung: Erlaubt GVFS, sich mit vielen Netzwerkprotokollen zu verbinden (smb://, nfs://, etc)
Paketname: gvfs-fuse
Kurzbeschreibung: Lässt nicht-GNOME-Anwendungen GVFS über »fuse« benutzen
Paketname: libnotify-bin
Kurzbeschreibung: Binärdateien um Benachrichtigungs-Sprechblasen zu senden
Paketname: light-locker

Kurzbeschreibung: Simple session-locker for lightdm
Paketname: tumbler

Kurzbeschreibung: Xfce thumbnail daemon used by thunar and xfdesktop4
Paketname: xfce4-notifyd
Kurzbeschreibung: Hintergrunddienst für die Anzeige von Benachrichtigungen
Paketname: xfce4-indicator-plugin

Kurzbeschreibung: Panel plugin for the indicators ( indicator-application, indicator-sound)
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Attribution-ShareAlike 4.0 International

Creative Commons Corporation ("Creative Commons") is not a law firm and does not provide legal services or
legal advice. Distribution of Creative Commons public licenses does not create a lawyer-client or other relationship.
Creative Commons makes its licenses and related information available on an "as-is" basis. Creative Commons
gives no warranties regarding its licenses, any material licensed under their terms and conditions, or any related
information. Creative Commons disclaims all liability for damages resulting from their use to the fullest extent
possible.

Using Creative Commons Public Licenses

Creative Commons public licenses provide a standard set of terms and conditions that creators and other
rights holders may use to share original works of authorship and other material subject to copyright and
certain other rights specified in the public license below. The following considerations are for informational
purposes only, are not exhaustive, and do not form part of our licenses.

Considerations for licensors: Our public licenses are intended for use by those authorized to give the
public permission to use material in ways otherwise restricted by copyright and certain other rights.
Our licenses are irrevocable. Licensors should read and understand the terms and conditions of the
license they choose before applying it. Licensors should also secure all rights necessary before applying
our licenses so that the public can reuse the material as expected. Licensors should clearly mark any
material not subject to the license. This includes other CC-licensed material, or material used under an
exception or limitation to copyright. More considerations for licensors. [https://wiki.creativecommons.org/
Considerations_for_licensors_and_licensees#Considerations_for_licensors]

Considerations for the public: By using one of our public licenses, a licensor grants the public permission to
use the licensed material under specified terms and conditions. If the licensor’s permission is not necessary
for any reason–for example, because of any applicable exception or limitation to copyright–then that use
is not regulated by the license. Our licenses grant only permissions under copyright and certain other
rights that a licensor has authority to grant. Use of the licensed material may still be restricted for other
reasons, including because others have copyright or other rights in the material. A licensor may make special
requests, such as asking that all changes be marked or described. Although not required by our licenses, you
are encouraged to respect those requests where reasonable. More considerations for the public. [https://
wiki.creativecommons.org/Considerations_for_licensors_and_licensees#Considerations_for_licensees]

Creative Commons Attribution-ShareAlike 4.0 International Public License

By exercising the Licensed Rights (defined below), You accept and agree to be bound by the terms
and conditions of this Creative Commons Attribution-ShareAlike 4.0 International Public License ("Public
License"). To the extent this Public License may be interpreted as a contract, You are granted the Licensed
Rights in consideration of Your acceptance of these terms and conditions, and the Licensor grants You such
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rights in consideration of benefits the Licensor receives from making the Licensed Material available under
these terms and conditions.

1. Definitions.

a. Adapted Material means material subject to Copyright and Similar Rights that is derived from or
based upon the Licensed Material and in which the Licensed Material is translated, altered, arranged,
transformed, or otherwise modified in a manner requiring permission under the Copyright and Similar
Rights held by the Licensor. For purposes of this Public License, where the Licensed Material is a musical
work, performance, or sound recording, Adapted Material is always produced where the Licensed
Material is synched in timed relation with a moving image.

b. Adapter's License means the license You apply to Your Copyright and Similar Rights in Your
contributions to Adapted Material in accordance with the terms and conditions of this Public License.

c. BY-SA Compatible License means a license listed at creativecommons.org/compatiblelicenses
[https://creativecommons.org/compatiblelicenses], approved by Creative Commons as essentially the
equivalent of this Public License.

d. Copyright and Similar Rights means copyright and/or similar rights closely related to copyright
including, without limitation, performance, broadcast, sound recording, and Sui Generis Database
Rights, without regard to how the rights are labeled or categorized. For purposes of this Public License,
the rights specified in Section 2(b)(1)-(2) are not Copyright and Similar Rights.

e. Effective Technological Measures means those measures that, in the absence of proper authority,
may not be circumvented under laws fulfilling obligations under Article 11 of the WIPO Copyright Treaty
adopted on December 20, 1996, and/or similar international agreements.

f. Exceptions and Limitations means fair use, fair dealing, and/or any other exception or limitation to
Copyright and Similar Rights that applies to Your use of the Licensed Material.

g. License Elements means the license attributes listed in the name of a Creative Commons Public
License. The License Elements of this Public License are Attribution and ShareAlike.

h. Licensed Material means the artistic or literary work, database, or other material to which the Licensor
applied this Public License.

i. Licensed Rights means the rights granted to You subject to the terms and conditions of this Public
License, which are limited to all Copyright and Similar Rights that apply to Your use of the Licensed
Material and that the Licensor has authority to license.

j. Licensor means the individual(s) or entity(ies) granting rights under this Public License.

k. Share means to provide material to the public by any means or process that requires permission
under the Licensed Rights, such as reproduction, public display, public performance, distribution,
dissemination, communication, or importation, and to make material available to the public including
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in ways that members of the public may access the material from a place and at a time individually
chosen by them.

l. Sui Generis Database Rights means rights other than copyright resulting from Directive 96/9/EC of
the European Parliament and of the Council of 11 March 1996 on the legal protection of databases, as
amended and/or succeeded, as well as other essentially equivalent rights anywhere in the world.

m.You means the individual or entity exercising the Licensed Rights under this Public License. Your has
a corresponding meaning.

2. Scope.

a. License grant.

i. Subject to the terms and conditions of this Public License, the Licensor hereby grants You
a worldwide, royalty-free, non-sublicensable, non-exclusive, irrevocable license to exercise the
Licensed Rights in the Licensed Material to:

A. reproduce and Share the Licensed Material, in whole or in part; and

B. produce, reproduce, and Share Adapted Material.

ii. Exceptions and Limitations. For the avoidance of doubt, where Exceptions and Limitations apply to
Your use, this Public License does not apply, and You do not need to comply with its terms and
conditions.

iii. Term. The term of this Public License is specified in Section 6(a).

iv. Media and formats; technical modifications allowed. The Licensor authorizes You to exercise the
Licensed Rights in all media and formats whether now known or hereafter created, and to make
technical modifications necessary to do so. The Licensor waives and/or agrees not to assert any right
or authority to forbid You from making technical modifications necessary to exercise the Licensed
Rights, including technical modifications necessary to circumvent Effective Technological Measures.
For purposes of this Public License, simply making modifications authorized by this Section 2(a)(4)
never produces Adapted Material.

v. Downstream recipients.

A. Offer from the Licensor – Licensed Material. Every recipient of the Licensed Material automatically
receives an offer from the Licensor to exercise the Licensed Rights under the terms and conditions
of this Public License.

B. Additional offer from the Licensor – Adapted Material. Every recipient of Adapted Material from
You automatically receives an offer from the Licensor to exercise the Licensed Rights in the
Adapted Material under the conditions of the Adapter’s License You apply.
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C. No downstream restrictions. You may not offer or impose any additional or different terms or
conditions on, or apply any Effective Technological Measures to, the Licensed Material if doing so
restricts exercise of the Licensed Rights by any recipient of the Licensed Material.

vi. No endorsement. Nothing in this Public License constitutes or may be construed as permission
to assert or imply that You are, or that Your use of the Licensed Material is, connected with, or
sponsored, endorsed, or granted official status by, the Licensor or others designated to receive
attribution as provided in Section 3(a)(1)(A)(i).

b. Other rights.

i. Moral rights, such as the right of integrity, are not licensed under this Public License, nor are
publicity, privacy, and/or other similar personality rights; however, to the extent possible, the
Licensor waives and/or agrees not to assert any such rights held by the Licensor to the limited extent
necessary to allow You to exercise the Licensed Rights, but not otherwise.

ii. Patent and trademark rights are not licensed under this Public License.

iii. To the extent possible, the Licensor waives any right to collect royalties from You for the exercise of
the Licensed Rights, whether directly or through a collecting society under any voluntary or waivable
statutory or compulsory licensing scheme. In all other cases the Licensor expressly reserves any
right to collect such royalties.

3. License Conditions.

Your exercise of the Licensed Rights is expressly made subject to the following conditions.

a. Attribution.

i. If You Share the Licensed Material (including in modified form), You must:

A. retain the following if it is supplied by the Licensor with the Licensed Material:

i. identification of the creator(s) of the Licensed Material and any others designated to receive
attribution, in any reasonable manner requested by the Licensor (including by pseudonym if
designated);

ii. a copyright notice;

iii. a notice that refers to this Public License;

iv. a notice that refers to the disclaimer of warranties;

v. a URI or hyperlink to the Licensed Material to the extent reasonably practicable;

B. indicate if You modified the Licensed Material and retain an indication of any previous
modifications; and
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C. indicate the Licensed Material is licensed under this Public License, and include the text of, or the
URI or hyperlink to, this Public License.

ii. You may satisfy the conditions in Section 3(a)(1) in any reasonable manner based on the medium,
means, and context in which You Share the Licensed Material. For example, it may be reasonable
to satisfy the conditions by providing a URI or hyperlink to a resource that includes the required
information.

iii. If requested by the Licensor, You must remove any of the information required by Section 3(a)(1)(A)
to the extent reasonably practicable.

b. ShareAlike.

In addition to the conditions in Section 3(a), if You Share Adapted Material You produce, the following
conditions also apply.

i. The Adapter’s License You apply must be a Creative Commons license with the same License
Elements, this version or later, or a BY-SA Compatible License.

ii. You must include the text of, or the URI or hyperlink to, the Adapter's License You apply. You may
satisfy this condition in any reasonable manner based on the medium, means, and context in which
You Share Adapted Material.

iii. You may not offer or impose any additional or different terms or conditions on, or apply any Effective
Technological Measures to, Adapted Material that restrict exercise of the rights granted under the
Adapter's License You apply.

4. Sui Generis Database Rights.

Where the Licensed Rights include Sui Generis Database Rights that apply to Your use of the Licensed
Material:

a. for the avoidance of doubt, Section 2(a)(1) grants You the right to extract, reuse, reproduce, and Share
all or a substantial portion of the contents of the database;

b. if You include all or a substantial portion of the database contents in a database in which You have Sui
Generis Database Rights, then the database in which You have Sui Generis Database Rights (but not
its individual contents) is Adapted Material, including for purposes of Section 3(b); and

c. You must comply with the conditions in Section 3(a) if You Share all or a substantial portion of the
contents of the database.

For the avoidance of doubt, this Section 4 supplements and does not replace Your obligations under this
Public License where the Licensed Rights include other Copyright and Similar Rights.

5. Disclaimer of Warranties and Limitation of Liability.
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a. Unless otherwise separately undertaken by the Licensor, to the extent possible, the Licensor
offers the Licensed Material as-is and as-available, and makes no representations or warranties
of any kind concerning the Licensed Material, whether express, implied, statutory, or other. This
includes, without limitation, warranties of title, merchantability, fitness for a particular purpose,
non-infringement, absence of latent or other defects, accuracy, or the presence or absence of
errors, whether or not known or discoverable. Where disclaimers of warranties are not allowed
in full or in part, this disclaimer may not apply to You.

b. To the extent possible, in no event will the Licensor be liable to You on any legal theory (including,
without limitation, negligence) or otherwise for any direct, special, indirect, incidental,
consequential, punitive, exemplary, or other losses, costs, expenses, or damages arising out of
this Public License or use of the Licensed Material, even if the Licensor has been advised of
the possibility of such losses, costs, expenses, or damages. Where a limitation of liability is not
allowed in full or in part, this limitation may not apply to You.

c. The disclaimer of warranties and limitation of liability provided above shall be interpreted in a manner
that, to the extent possible, most closely approximates an absolute disclaimer and waiver of all liability.

6. Term and Termination.

a. This Public License applies for the term of the Copyright and Similar Rights licensed here. However,
if You fail to comply with this Public License, then Your rights under this Public License terminate
automatically.

b. Where Your right to use the Licensed Material has terminated under Section 6(a), it reinstates:

i. automatically as of the date the violation is cured, provided it is cured within 30 days of Your
discovery of the violation; or

ii. upon express reinstatement by the Licensor.

For the avoidance of doubt, this Section 6(b) does not affect any right the Licensor may have to seek
remedies for Your violations of this Public License.

c. For the avoidance of doubt, the Licensor may also offer the Licensed Material under separate terms or
conditions or stop distributing the Licensed Material at any time; however, doing so will not terminate
this Public License.

d. Sections 1, 5, 6, 7, and 8 survive termination of this Public License.

7. Other Terms and Conditions.

a. The Licensor shall not be bound by any additional or different terms or conditions communicated by
You unless expressly agreed.

b. Any arrangements, understandings, or agreements regarding the Licensed Material not stated herein
are separate from and independent of the terms and conditions of this Public License.
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8. Interpretation.

a. For the avoidance of doubt, this Public License does not, and shall not be interpreted to, reduce, limit,
restrict, or impose conditions on any use of the Licensed Material that could lawfully be made without
permission under this Public License.

b. To the extent possible, if any provision of this Public License is deemed unenforceable, it shall be
automatically reformed to the minimum extent necessary to make it enforceable. If the provision
cannot be reformed, it shall be severed from this Public License without affecting the enforceability of
the remaining terms and conditions.

c. No term or condition of this Public License will be waived and no failure to comply consented to unless
expressly agreed to by the Licensor.

d. Nothing in this Public License constitutes or may be interpreted as a limitation upon, or waiver of, any
privileges and immunities that apply to the Licensor or You, including from the legal processes of any
jurisdiction or authority.

Creative Commons is not a party to its public licenses. Notwithstanding, Creative Commons may elect
to apply one of its public licenses to material it publishes and in those instances will be considered the
„Licensor.“ The text of the Creative Commons public licenses is dedicated to the public domain under the
CC0 Public Domain Dedication [https://creativecommons.org/publicdomain/zero/1.0/legalcode]. Except for
the limited purpose of indicating that material is shared under a Creative Commons public license or as
otherwise permitted by the Creative Commons policies published at creativecommons.org/policies [https://
creativecommons.org/policies], Creative Commons does not authorize the use of the trademark „Creative
Commons“ or any other trademark or logo of Creative Commons without its prior written consent including,
without limitation, in connection with any unauthorized modifications to any of its public licenses or any
other arrangements, understandings, or agreements concerning use of licensed material. For the avoidance
of doubt, this paragraph does not form part of the public licenses.

Creative Commons may be contacted at http://creativecommons.org/.
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